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VISUAL SHOW DIRECTOR 8 Getting Started

VISUAL SHOW DIRECTOR 8 Getting Started

THIS GUIDE IS FOR "SHOW DIRECTOR" (NON VISUAL) AND "VISUAL SHOW DIRECTOR"

REFRESH YOUR BROWSER TO GET THE LATEST UPDATES OF THE USER'S GUIDE (Version 8.3.0)

When you receive the installation package and install the applications follow the Registration procedure.

For help on this procedure see:
http://www.infinityvisions.com/showdirector/ivActivationHelp.asp

Familiarize yourself with the Visual Show Director User's Guide. You will find here
answers to your questions.

Watch our Video Tutorials on various topics of the software.

Download this user guide in Word format.

Download this user guide PDF format

Download this user guide in HTML format

Created with the Personal Edition of HelpNDoc: Easily create PDF Help documents

Introduction

Introduction

This guide is designed to introduce you to the use of "Show Director" and "Visual Show
Director".

Show Director is a professional tool for designing pyrotechnic pyromusical shows for a
variety of firing systems. 
.

http://www.infinityvisions.com/showdirector/ivActivationHelp.asp 
http://www.infinityvisions.com/showdirector/ivActivationHelp.asp 
http://www.infinityvisions.net/software/vsd8-tutorials/
www.infinityvisons.net/Documentation/HELP-VSD/VISUAL SHOW DIRECTOR 833.docx
/Documentation/HELP-VSD/VISUAL SHOW DIRECTOR 833.docx
/Documentation/VISUAL SHOW DIRECTOR 833.html
http://www.helpndoc.com/feature-tour


VISUAL SHOW DIRECTOR 8

6 / 119

Visual Show Director provides you with additional Visual Applications, for 3D visualization of
fireworks. lasers, lights, image projections and objects animation to enhance your creative
experience.

In the following guide we will use only the name "Visual Show Director". For "Show
Director" users disregard references to visualization.

WATCH VIDEO INTRODUCTION

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

How to use this guide

How to use this Guide

The guide is divided into several chapters. You can read the chapters in order, or you can
read the rest of this Introduction and then start with the chapter that best suits your
interest and experience. Within each chapter, we recommend following the instructions in
order.

Created with the Personal Edition of HelpNDoc: Free Web Help generator

Other Resources

Other Resources

Visual Show Director includes a variety of resources to help you learn the program quickly
and become proficient in creating your own effects and libraries. These resources include the
following:

·A Demo Project
Included in the installation package there is a Demo Project to start practicing with.

·Visual Show Director's Online Help
Includes comprehensive information about using all aspects of Visual Show Director, as well
as an HTML version online and video tutorials.www.infinityvisions.net/software/
documentation 

·Visual Show Director  in program Help is located in the installation folder as vsd.chm.

In addition, you may find updated versions of this help and video tutorials on our website.

WATCH VIDEO INTRODUCTION

https://youtu.be/J-yOsjInjCc
http://www.helpndoc.com/help-authoring-tool
http://www.helpndoc.com
http://www.infinityvisions.net/software/documentation/
https://youtu.be/J-yOsjInjCc
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Created with the Personal Edition of HelpNDoc: Produce electronic books easily

Upgrading to version 8 from previous versions

Upgrading from Previous Versions: What is new in Show Director 8

If you are a new user or are upgrading to version 8 from previous versions here are all the
new features. 

For Importing Previous versions Projects see Video Tutorial here.
   

WHAT IS NEW IN VERSION 8.3?  

Read Release Notes

WATCH VIDEO

BACKWARDS COMPATIBLE

·Project Import in the "Project Library". Will import older projects, versions 5,6,7 and will export a copy of
a VSD8 project. It will make a copy of all the older files selected and a new .pyr.
Export will export to versions 5, 6 , 7 or make a copy of version 8 projects and selected files.

·Direct open/import from the "File menu" of "Scripts", "Effects Manager"s, Sorts and Filters from versions
5,6, and 7.
Copies of original version files will be saved as "samename". "file extension".bak in the same folder.
Older projects can not be opened directly from the File Menu, they need to be imported with Project
Library.

·Project Save As… Makes a copy of the existing .grx and .atb files and copies them to the new project
before it saves. This fixes the missing column colors/formatting in the new project if the script windows
was closed.4. Automatic version update notifications.5. You can now associate ShowDirector8 to .pyr
project files. This allows you to double click a .pyr project file and have ShowDirector open with that
project loaded.

AUTO-RESTORE (UNDO)

·New Auto Restore for Scripts and Effects Managers. This new function will keep a backup of your most
recent Scripts or Effects Managers making a copy of the files every 5 minutes within 1 hour. There will be
12 copies that you can restore at any point on time. The feature is only active with a project open. The
backup files are stored in a folder inside the directory where the project is saved.The function can be
manually deactivated by changing On to Off in the file sd.ini in C:/Users/username/Appdata/Roaming/
ShowDirector. You will never lose more than 5 minutes of work.

http://www.helpndoc.com/create-epub-ebooks
https://youtu.be/J-yOsjInjCc
http://www.infinityvisions.net/Documentation/Show%20Director%208.3%20Release%20Notes%203.pdf
http://www.infinityvisions.net/Documentation/Show%20Director%208.3%20Release%20Notes%203.pdf
https://youtu.be/3vBT8fgWz4g
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MORE COLUMNS

·Added new Script columns; MS (MILLISECONDS),MACRO,GROUP,TABLE,MODE, CONTROLLER, MODULE,
PIN, CUSTOM 3>8, LOCK1 > LOCK 8 columns added to Script. Included in Filter and Sort. This supports
different firing system functionalities. The new columns are initially hidden and you can show them with
the show/hide tool in the format toolbar.

·Added new columns to Effects Manager grid: Custom3-5. The columns from Effects Manager overwrite
the values in Script Manager. Script Manager. also got three additional Custom (6-8) that do not get
overwritten as they don't exist in effects. All new columns are shown. REF column widened from 16 to 50
characters.

·All ShowDirector Managers Grids now support Column Cut and Paste. It is limited to columns on the
same grid and of the similar data types. Some data types can't be copied between columns (for example,
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while you can put a CUE number into a text field such as CUSTOM3, you can't put that CUSTOM3 value
back into the CUE).
To copy a column or a section of it: select the cell to start, press Shift and select the last row, press Shift-
F4 or the icon tool in the Sort/Filter toolbar, click in the cell you want to start the paste and press Shift+F5
or icon tool.

MULTI-FIRING SYSTEM SCRIPTING

·Script Import and Export for: FireOne (.fir) , Galaxis, PyroLeda, Explo, Cobra...

·The Script Open and Save As and have been expanded to include the new columns. Script Open from
.xls, or .csv and older scripts (VSD 5,6,7) that do not have the new columns. The new columns will be
blank.
Columns in Excel have to be named with the same characters and format as VSD.
Excel with one workbook has to be named as "Sheet1".
The Effects Manager export and import has .csv and Excel (.xls) format.

MULTI FIRING SYSTEM AUTO-ADDRESSING

·New Renumber Address dialog for ADDR and Module/Pin will dynamically display the Script Sort you have
(up to 10 columns) that can be selected to cause the Renumber to increment to the next Module when
that value in that column changes. It also allows you to specify if you want the pin addresses to increment
or decrement (default). Once a module is full, we increment to the next module. The Reset Address also
has a new dialog that allows you to specify either

ADDR or MODULE/PIN

·The Validate Addresses form has now a Module Report function that will display a count of Total Firing
Modules and available pins not used.

·Reset Address, Renumber Address and Validate Address now work on both ADDR column and the new
MODULE/PIN columns. When you run the menu items, it works on both the ADDR and MODULE/PIN.

·Module and Pin AutoComplete. You can AutoComplete incrementing or decrementing by any amount.
Currently the maximum pin value is 100. To AutoComplete select first cell and shift last row and press
CTRL+F9

NEW TIME FORMATS AND DIRECT EDIT AND SEQUENCING IN THE TIME COLUMNS

·Cue Time (HH MM SS FF) remain in frame rate. We have added a MS (milliseconds) column that
contains the Cue Time represented in total milliseconds. If you change any of the Cue Time values, the MS
column will update. If you change the MS column, the Cue Time values will update.

·The Next column has been changed to allow edits. This makes the interval between two cues as settable.
If you change the value of in the Next column, the Cue Time and MS will update. If other Next values exist,
then all following Cue Times will also update with their intervals. Thus, if you change a Next time interval,
you slide the entire show by that much time. How this effects the show can be manipulated by the filters
and selections you have in place at the time of the edit to the Next value. Copy Down and AutoComplete
also works for the Next column allowing you to generate linear and curved interval sequences. A valid Next
edit can be as a number from 1 on up as milliseconds or in the format of mm:ss:ms (minutes, seconds,
milliseconds), however the display will always show mm:ss:ms.
It is also possible to Copy parts of the NEXT column and Paste in other Cues to set the same intervals.

·Increased the precision of the PFT (Pre-Fire Time) from 1/10s of a second to milliseconds. You can enter
any number from 1 (millisecond) to 9999. Zero is still valid and indicates no pre-fire time. This change
should be reflected in both the Script and the Effects files. When exporting to previous versions it will
reformat the PFT as 1/10 sec. When importing from older versions it will convert 1/10 sec into
milliseconds. When creating the Firing Table .tab for the PD Field Controller it will export as 1/10sec.

http://www.infinityvisions.net/doc_vsd/cm_renumberaddresses.html
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·Configure Timecode form now allows to change the Frames format of the open Script. If you are in 30fps
and select 25fps the Script will change to that format.

FIND-REPLACE & ADDITIVE FILTERS

·Added universal Find/Replace in all the Managers. Shift+F3.

·Script and Effects Quick Filter are additive now. If you have a filter in place and select a new Quick Filter,
it will add to the end of the existing filter. This continues until you select Reset Filter.

USER INTERFACE ADAPTABILITY

·Added Major Version number (8) to the .grx and .atb filenames. This will help facilitate the organization
and addition of new columns and tools to ShowDirector.
The default toolbar (.atb in appdata/roaming/ShowDirector) when it opens does not show all the toolbars
possible. To Open other toolbars, right click in the grey area and select them from the menu or from
Customize.

·The default grid (.grx in appdata/roaming/ShowDirector) has a new order of columns and doesn't show
all the columns possible. If you want to reorganize this default grid, show more columns or hide other and
in different order, do the following. Reopen ShowDirector, do not open a project, Open a new script,
show/hide and reorder, do the same with toolbars shown/hidden and distribution. Close the script. Restart
Show Director. The new default layout will be displayed. Colors for colors are only part of a Project. If you
want to use a particular project layout, make a template and every time you make a new project open the
template first and save the new project with new name.

·ToolbarLayout (.atb) and GridLayout (.grx) files gained the Minor version number. This means if a menu
changes or a grid column changes, we will advance the product Minor version and refuse to load the old,
out-of-date layout files. A side effect is that any custom formatting in the old version is lost to the new
version. Default .atb and .grx files in the users/AppData/Roaming/ShowDirector folder have been made
Read-Only to preserve them against possible corruption by loading out of date script or effect files when
no project has been loaded.

Here is a list of what was new in version 7
     

· Toolbars
· Complete overhaul of menu system to modern, XP style, breakaway toolbars. Toolbars are grouped

according to function and may be placed anywhere - top, bottom, left, or right side or desktop.
· All major functions are easily accessible with a single click.
· User has control over which toolbars are visible and icons shown.
· One click formatting of all grid columns - font, font size, font style, alignment, and colors.
· Different toolbar layouts are supported for each named project.
· Different grid layouts and formatting supported for each named project.
· Select available windows from the new Window List.

Script and Effect Manager
· Columns can be re-ordered to your preference, simply by selecting the header and dragging to

desired location.
· 32 named "Views" are supported for each Manager. A View is a Filter, a Sort, or a combination of

both.
· View, Filter, and Sort selection toolbars provide rapid access.
· Unlimited number of Named and Storable filters.
· Script and Effects Managers may be filtered by one or all columns.
· Unlimited number of Named and Storable sorts.
· Script and Effects Managers may be sorted by one or all columns, ascending or descending.
· Single click, column sort available on toolbar for fast access.
· Single click, Sort by Time for Script Manager, available on toolbar.
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· Single click, quick Filter by cell value available on toolbar.
· Single Click, Unfiltered Cues.
· Sort grid displays dynamically arranges columns by sort order.
· Import and export Show Scripts, Cues and Effects easily.
· Export effects from Script to new Effect Manager files.
· Paste, Import Cues works now in multiple cue selection.
· Copy-Cut-Paste text within cells.
· Offset Cues, works now in Cues selections.

Firing Tables Manager
· New, integrated Firing Table Manager supports multiple Field Controllers.
· Integrated Firing Table Manager consolidates all functions to create and download tables to

Pyrodigital Field Controller on a single screen.

WAVE Display
· Improved control of WAV playback. Double-click to start playing. Single click left button to seek,

single click right button to stop and seek.

File Interface
· Project Library. In this new menu you can see, select and copy all the project files to a new folder

for filing or sending to another user. The project configurations , settings and file paths are saved.
· Improved Script and Effect import and export to CSV format support.
· Recent Project File list aids quickly opening up 5 most recent projects.
· File open remembers your last directory.
· Print all grids in WYSIWYG format, as displayed on screen.
· File support and Plug-In ready for "Visual Show Director" fireworks simulation software.

Upgrading from 4.0: What was new in Show Director 5.0.5
   
   Visual Show Director  includes all the features of Show Director 5.0.5.  Here is a list of what was new in version 5.0.5 
     

·Toolbars
·Complete overhaul of menu system to modern, XP style, breakaway toolbars. Toolbars are grouped
according to function and may be placed anywhere   top, bottom, left, or right side or desktop.
·All major functions are easily accessible with a single click.
·User has control over which toolbars are visible and icons shown.
·One click formatting of all grid columns   font, font size, font style, alignment, and colors.
·Different toolbar layouts are supported for each named project.
·Different grid layouts and formatting supported for each named project.
·Select available windows from the new Window List.

Script and Effect Manager
·Columns can be re-ordered to your preference, simply by selecting the header and dragging to desired
location.
·32 named  Views  are supported for each Manager. A View is a Filter, a Sort, or a combination of both.
·View, Filter, and Sort selection toolbars provide rapid access.
·Unlimited number of Named and Storable filters.
·Script and Effects Managers may be filtered by one or all columns.
·Unlimited number of Named and Storable sorts.
·Script and Effects Managers may be sorted by one or all columns, ascending or descending.
·Single click, column sort available on toolbar for fast access.



VISUAL SHOW DIRECTOR 8

12 / 119

·Single click, Sort by Time for Script Manager, available on toolbar.
·Single click, quick Filter by cell value available on toolbar.
·Single Click, Unfiltered Cues.
·Sort grid displays dynamically arranges columns by sort order.
·Import and export Show Scripts, Cues and Effects easily.
·Export effects from Script to new Effect Manager files.
·Paste, Import Cues works now in multiple cue selection.
·Copy-Cut-Paste text within cells.
·Offset Cues, works now in Cues selections.

Firing Tables Manager
·New, integrated Firing Table Manager supports multiple Field Controllers.
·Integrated Firing Table Manager consolidates all functions to create and download tables to Pyrodigital
Field Controller on a single screen.

WAVE Display
·Improved control of WAV playback. Double-click to start playing. Single click left button to seek, single
click right button to stop and seek.

File Interface
·Project Library. In this new menu you can see, select and copy all the project files to a new folder for
filing or sending to another user. The project configurations , settings and file paths are saved.
·Improved Script and Effect import and export to CSV format support.
·Recent Project File list aids uickly opening up 5 most recent projects.
·File open remembers your last directory.
·Print all grids in WYSIWYG format, as displayed on screen.
·File support and Plug-In ready for  Visual Show Director  fireworks simulation software.

Dongle Key
·New USB and Parallel Port protection key, upgrade remotely. Demo version available.

 

 

 

 

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

Language Settings

LANGUAGE SELECTION TOOL

All the Visual Applications of Visual Show Director, are available in different languages.
To select the language in use, please use the Language Selection Tool, available in the Visual

http://www.helpndoc.com
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Show Director folder as shown in the following illustration.

The tool interface is very simple and it is enough to select a language from the ones available
and press the [APPLY] button.
The next time the visual tools are run, they will be in the desired language.

Currently available languages: English, Spanish,Japanese,French. Korean, Chinese
Simplified, Chinese Traditional.

The text maps of language correspondences are located in:C:\Program Files (x86)
\ShowDirector8\Visual\Resources\Messages

If you are interested in correcting or translating Visual Show Director in your language, make
any changes in the .txt files and send an email to vsd@infinityvisions.com

Created with the Personal Edition of HelpNDoc: Easily create EBooks

Show Director Overview

Visual Show Director  Overview

This is an overview of the files system structure of Visual Show Director 
It shows how all files are related and tied together in the Project.

Download the Visual Show Director Files structure Map

mailto:showdirector@infinityvisions.com
http://www.helpndoc.com/feature-tour
http://www.infinityvisions.net/pdf/VSD_Map.pdf
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·Visual Applications

o  FX Generator
Is the application used for the creation of the effects and Libraries.
click here for more information

o  3D Position Editor
Is the application used for the creation of the effects and Libraries.
click here for more information

o  Producer
Is the application used for the creation of the effects and Libraries.
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click here for more information

o  Viewer
Is the application used for the creation of the effects and Libraries.
click here for more information

Created with the Personal Edition of HelpNDoc: Generate EPub eBooks with ease

The Toolbars

The Toolbars

The tool bars let's you have all the commands conveniently accessible. They are fully
customizable.
The tool bars offer you quick access to the VSD functions and commands. It is VERY
IMPORTANT that you take the time to go with your mouse over them to see what each one
does. Click and try them.

They are saved with the project. In this way when you reopen, everything will be in
the exact place that you left it

· Tool bar Features:

o Can be placed anywhere in the Show Director window or in the Desktop.
click here for more information on how to relocate toolbars

o Can be customized: Add or Remove Icons, Add Name tag to Icon, Icon size.
click here for more information on how to customize toolbars

o Function of the Icon is displayed when the mouse is over the icon.
A tool tip always shows a description of the command

o The tool bars position in the user interface are saved in the .atb file. Each
project can have a specific tool bar layout or arrangement.
If you want to use a tool bar layout as the default, copy the file
"myproject.ToolBarLayout.atb" in the project folder where you made it and place
it in C:/Users/"your username"/Appdata/Roaming/ShowDirector folder and rename
it as "ToolBarLayout82.atb". After that in any new project it will be the default
layout.

o All the tools can be accessed from the Menus, so in order to save space in the
screen you want to use only the most frequently used. This is the default original
layout in the application.

The available Toolbars

http://www.helpndoc.com/create-epub-ebooks
movingtoolbars.html
customizingtoolbars.html
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·Tool bar Features:
o Can be placed anywhere in the Show Director window or in the Desktop.

click here for more information on how to relocate tool bars

o Can be customized: Add or Remove Icons, Add Name tag to Icon, Icon size.
click here for more information on how to customize tool bars

o Function of the Icon is displayed when the mouse is over the icon.
A tool-tip always shows a description of the command

Created with the Personal Edition of HelpNDoc: Free EPub producer

Toolbars Interaction

Toolbars Interactions

Any Tool bar can be moved, docked in another place or left floating in the screen.

http://www.helpndoc.com/create-epub-ebooks
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·To move a tool bar, Drag & Drop it using the Handle shown in the next illustration

·To close a floating tool bar, click on the X as shown in the next illustration

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Toolbars Customization

Toolbars Customization

Any Toolbar can be customized with custom tools and it is also possible to create new
custom toolbars to suit your needs.

http://www.helpndoc.com/feature-tour
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To show/hide a toolbar, right click with the mouse on an
empty space of the toolbar and select from the popup
menu shown in the next illustration the toolbar to show/
hide.

To customize toolbars,choose customize from the toolbars context menu. A new window
with all the custom tools will popup.

Created with the Personal Edition of HelpNDoc: Free help authoring tool

Script and Effects Managers Common Tools

Script and Effects Managers Common Tools

http://www.helpndoc.com/help-authoring-tool
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The Script and Effects Manager share these common tools.

Fonts Format tools

Ordered from left to right:

Sort Script by Time (Ctrl-T)  Sorts the script by time.

Sort Ascending

Sort Descending

Sort Selection Ascending

Sort Selection Descending

Find Replace
Universal Find/Replace in all the Managers. Shift+F3 

All ShowDirector Managers Grids now support Column Copy, Cut and Paste. It is limited to
columns on the same grid and of the similar data types. Some data types can't be copied
between columns (for example, while you can put a CUE number into a text field such as
CUSTOM3, you can't put that CUSTOM3 value back into the CUE).

Copy Column  Copies a selection in a Column. Select first cell and press Shift to select the last row of the
selection. Click the icon of the tool. Copies data.

Paste Column. Pastes copied data of the same format into another column. Select the cell  to insert
copied data and press the icon tool.

Quick Filter - Reset Filter - Unfiltered Rows
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Script and Effects QuickFilter are additive now. If you have a filter in place and select a new
QuickFilter, it will add to the end of the existing filter. This continues until you select Reset
Filter.

Created with the Personal Edition of HelpNDoc: Easy EBook and documentation generator

Visual Applications

Visual Applications

Visual Show Director integrates a set of applications that allow three dimensional creation
and visualization of fireworks, special effects, lights and laser beams, image projections and
movement of objects in a 3 Dimensional environment.

Visual Show Director Multimedia Version is a complete fireworks and multimedia show
authoring application that includes all of the above features not available in ShowDirector.

·Visual Applications

 FX Generator
This application is used for the creation of the Effects and Libraries.
click here for more information

 3D Position Editor
This application is used for the creation of Sites, Positions, Objects and Light Beams
Keyframing animation .
click here for more information

 Producer
This application is used to publish your show in a variety of picture and video formats,
including stereoscopic images, and create VSDPlayer files
click here for more information

 Viewer
This application is used to visualize your show in real time.
click here for more information

WATCH WHAT IS POSSIBLE

Created with the Personal Edition of HelpNDoc: Free HTML Help documentation generator

FX-Generator

FX GENERATOR

The FX Generator is the application used for the creation of the effects and Libraries of
effects.

With the FXGenerator you will produce Visual Reference codes that are associated with the

http://www.helpndoc.com
http://www.infinityvisions.net/videos/CHAMPIONS2017VIDEO-desktop.m4v?_=1
http://www.helpndoc.com
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effects in the Effect Manager and translated to the Visual Reference field in the Script
Manager.
This allows the Viewer to interpret and animate the effects.

For complete details on the FX Generator , please refer to its User's Guide

A Typical FX GENERATOR layout

Created with the Personal Edition of HelpNDoc: Free Kindle producer

Producer

PRODUCER

The producer contains the functions to create snapshots, video and frames starting from a
project file. The producer can generate media of any type from a script that can play 2D or
3D shows, plus the option to create stereo or auto-stereo frames.

The quality of the video is set by the Video Codec that you use and installed in your system.
There are many packages of Video Codecs for download in the Internet. Choose a reliable
one.

For encoding the Audio in your system you need to run this Encoder. ( An error will appear if
you do not have permissions to encode mp3)

·Snapshots: the parameters are:
o type of image file (.jpg, .pcx, .bmp, .tga);
o destination filename;

http://www.infinityvisions.net/Documentation/HELP-FXGEN/interface.html
http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
https://en.wikipedia.org/wiki/Video_codec
file:///https://www.dropbox.com/sh/g7yaqoy3jniwsug/AABqi_fJ0PYJCquDDJDflPOda/VSDProducer-fix-mp3-codec.cmd?dl=0
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o Image quality and parameters (gamma correction, jpeg quality, etc etc.);
o snapshot time;
o flag for stereo or autostereo;
o path in meters for the camera;
o flag for alpha bitmaps;

·Video: the parameters are:
o Type of video files (.avi, .mpg, .wmv, etc etc.)
o Destination filename;
o Codec to use and codec options;
o Sound flag;
o Starting frame;
o Ending frame;
o "Take all the show" flag;

·Frames: the parameters are:
o Type of image file (.jpg, .pcx, .bmp, .tga);
o Destination filename;
o Image quality and parameters (gamma correction, jpeg quality, etc etc.);
o Flag for stereo or auto-stereo;
o Path in meters for the camera;
o Flag for alpha bitmaps;
o Starting frame;
o Ending frame;
o "Take all the show" flag;

·Executable: the parameters are:
o destination filename;
o flag for playing the show in stereo mode;
o path in meters for the camera;
o starting frame;
o ending frame;
o take all the show" flag;

For complete details on the PRODUCER , please refer to its User's Guide

The PRODUCER interface
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Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

3D Position Editor

3D Position Editor

The application is used to create position sites, generate light beam animation effects and
animate 3dimensional objects.

Library: shows the content of a position library; a library consists of a collection of sites;
each site consist of a background filename (3d model: .3ds or bitmap file: .bmp, .jpg, or
.tga), stage size and square size factor, sky and terrain bitmap filenames, etc.

Object Hierarchy: this panel shows the object hierarchy tree, i.e. a tree that shows the
relationship between the several objects inside a site.

Position Grids: this panel shows, for each site, the positions like a database, so the user
can modify positions coordinates and attributes by typing in this grids.

Key-framing: this panel shows a time line that can be used to establish an animation for a
beam or for an object.

Tool Options: this panel shows all the options relative to a particular tool;

Groups and Selections: this panel shows the tools relative to group of positions.

http://www.helpndoc.com
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If you are using Visual and don't want to have all the positions listed you can create a group
of positions in the 3D Position Editor. Then use @groupname in the cue. It will fire from all
the positions in the group. Obviously for the addressing and set up you have to paste all the
positions in that @ cue. If you made an empty script with all the positions in the groups, use
Import Cues to paste them, and then fill down the parameters of the cue and the REF for
inserting same effects.

For complete details in the 3D POSITION EDITOR , please refer to its User's Guide

A Typical 3D POSITION EDITOR layout

The CHM file was converted to HTML by chm2web software.

Created with the Personal Edition of HelpNDoc: Free iPhone documentation generator

Viewer

VIEWER

The Viewer is the component that visually plays a show. The component works in window
mode.

Window mode: the component runs in a window, and the controls (play, stop, etc.) are
outside the Viewer and shared with Show Director.
The options are customizable.

http://www.infinityvisions.net/Documentation/HELP-3DPOS/default.html
http://chm2web.aklabs.com
http://chm2web.aklabs.com
http://chm2web.aklabs.com
http://www.helpndoc.com/feature-tour/iphone-website-generation
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The Viewer application automatically recognizes any change of time in the wave file while in
play and it is automatically synchronized.

IF AND ONLY IF YOU ARE USING EXTERNAL TIMECODE, INSTEAD OF A WAVE FILE, YOU
NEED TO PRESS THE  BUTTON ON THE VIEWER TOOLBAR TO INITIALIZE THE VIEWER
WITH THE ACTUAL TIMECODE.

Notes about the Viewer Interaction with external time-code
When using an external time-code source, such as Pyrodigital Modem, the Viewer waits for
the time-code Sync button  and then keeps going using an internal clock to save
resources.
Only if you change your time-code (i.e. using FFW or REW), then you need to press the Sync
button  once again to tell the application the new time it have to reinitialize the internal
clock.

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Interface

VIEWER INTERFACE

The Viewer main interface looks like this:

http://www.helpndoc.com/feature-tour
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The main window features a main display area, plus a toolbar to customize options and a
status bar to display information about the application.

The Viewer Keyboard controls

Camera Movement

Camera Zoom
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Camera Rotation

The Toolbars

The tool bar contains the commands to change camera position and orientation and the
rendering options.

·Available Tools
o  Show/Hide position dots:

this tool toggles the visibility of position markers, displayed as green dots on the
screen;

o  Show/Hide burst rise:
this tool toggles the visibility of the burst rise; the burst rise is the dot that appears
when a shell is shot from a position;

o  Reset Camera:
this tool resets the camera to the default position and orientation;

o  Make Snapshot:
this tool captures a snapshot of the actual view-port and saves it on file;

o  Options:
this tool brings up the Option window where advanced customization is possible.

The Status Bar

The Status Bar displays information about the number of particles used to display the actual
scene and information about the windows size (useful when taking snapshots).
·Notes about the Number of Particles The number of particles panels displays a counter
indicating how many particles are active on the screen.
The higher the number of particles, the more system resources are used. Please keep in mind
this equation when designing effects in the FX Generator.
The number of particles depends on the way each star type has been built (a star with tail is
made by several particles).

Created with the Personal Edition of HelpNDoc: Free EPub producer

Options

VIEWER OPTIONS

http://www.helpndoc.com/create-epub-ebooks
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The Viewer Option Window looks like the following illustration:

This window is organized in sections for an intuitive navigation
·General Options
The General Options section panel includes the common options used to show/hide objects
like positions, sky and terrain that are related to each site.
The option also includes the random rotation for shells, which makes the shells rotation
random as in the real world.

·Rendering
The Rendering Options section is related to the actual render used and includes:
o Filtering: this option makes the pictures applied to polygons more smooth; if you

disable this option, the pictures will be more sharp; disabling this option results in a
faster rendering.

o Mip-mapping: this option reduces pictures size depending on the distance from
camera; disabling this option results in a faster rendering.

o Enable light: this option enables lighting on the environment; when disabled, the
engine renders all the polygons with the same light; disabling this option result in a
faster rendering

o Position dot size: this option sets the size for the dot used to display the positions on
screen; the size is expressed in centimeters.

o Sound Effects: The Sound Effects options section includes a check-box to toggle
sounds on/off. Sound volume can be adjusted using the +/- buttons

o Interface: the Interface section includes the FOV (Field Of View), expressed in
degrees, and the height variation used to add that little touch of inaccuracy typical of
the real world displays.
This section includes also the mouse sensitivity factor, adjustable using the +/-
buttons which establishes the relation between mouse movements and camera: the
higher this is set, the faster the camera movement (for very accurate movements, set
this value to a low number).

o Wind options: The wind options includes the wind force and angle; the angle
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establishes the wind direction, in a clockwise convention
o Window and Misc options: The Window and Misc options includes the actual window

size and the parameters related to stereographic pictures.
With the �Stereo Picture Width and �Stereo Picture Height, it is possible to set the size
for the stereo picture;
with the �Path in Meters it is possible to set the distance from the two cameras used to
produce a stereographic image.

At this point, it is possible to create a standard stereo picture using the �Make Stereo
Picture button or to create an auto stereo picture with the �Make Auto Stereo Picture
button.
The stereo picture will contain two pictures: one of them represents a snapshot from
the actual position of the camera minus the (path in meters)/2, and the other
represents a snapshot from the actual position of the camera plus the (path in
meters)/2.
The auto stereo picture will contain 9 pictures: the 9 pictures are placed in a 3x3 grid,
and each of them represents a snapshot from the actual position of the camera that
stands on the path.

o Particle Engine Properties: The Particle Engine Properties panel contains options to
customize the maximum number of head and tail particles that the engine will use to
draw particles.
This option shows the memory size consumption for the selected particles; to update
this value use the "Update Value" button.

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

Grid Formatting Layouts

Grid Formatting

It is possible to customize the grids appearance for each project using the [FORMAT] menu
and tool-bar.
All the changes to the grid are saved in the project folder with the filename 
[projectname.gridlayout.grx] and are automatically restored on project opening.

The Format Menu and the Formatting tool-bar

WATCH VIDEO Configure your own User Interface: Windows Tiling and
Layouts.

http://www.helpndoc.com
http://www.infinityvisions.net/videos/windows_tiling_layouts.mp4?_=9
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Created with the Personal Edition of HelpNDoc: Easy EBook and documentation generator

Grid Formatting by Columns

Grid Formatting by Columns

To assign a certain format property to a column:

·Select the column/s clicking on the column/s header

·Change the format option from the Format Menu or from the Formatting Toolbar.

If you want to change the name of a column,right click in the tag of the column and a
dialog will prompt you to change the names.

http://www.helpndoc.com
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Created with the Personal Edition of HelpNDoc: Create iPhone web-based documentation

Hide / Show Columns

Show / Hide Columns in the grid

Any column can be hidden or un hidden in a grid layout.
With this feature, Show Director allows the user to work with a subset of the columns for a
better organization

To Hide one or more columns
1.Select the columns using the columns headers
2.click on the closed eyes icon  in the [FORMATTING] toolbar

or select  from the [FORMAT] menu

To Show one or more columns
1.Select the columns using the columns headers
2.click on the closed eyes icon  in the [FORMATTING] toolbar

or select  from the [FORMAT] menu

3.Select the columns you want to show again in the dialog that pops up (see next
illustration)

http://www.helpndoc.com/feature-tour/iphone-website-generation
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Created with the Personal Edition of HelpNDoc: Easily create EBooks

Repositioning Columns

Change the Columns Position in the grid

Columns positions are customizable in Show Director

To change the position of a column in the grid layout

1.Select the column using the columns headers
2.Drag it to the desired position. A RED marker shows the insert point while dragging
3.Drop it in the new position

All the changes are displayed immediately and saved with the grid layout file.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

http://www.helpndoc.com/feature-tour
http://www.helpndoc.com/feature-tour
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Custom Views

Custom Views ( Show Director Tools Plug in)

From 8.2.14, Show Director Tools includes Custom Report and Views.  

We have added the ability to save a named Custom View that includes the Visible Script
Columns and their order plus whatever filters or sorts you may have in place. 
 
These Custom Views can be used in any project without having to load the original Script
Filter or Sort files. 

In addition to loading a Custom View, you have the ability to Print or Save the Script using
that View.  
Saving uses the Microsoft Excel format (.xls) and only saves the visible columns in order with
the filter and sort.  

This differs from normal Script Save as Excel which saves ALL columns and data.  
Use this feature to create Custom Reports that can be applied to any Project.  

A few commonly requested Custom Report Views have been included to get you started. 

\

Created with the Personal Edition of HelpNDoc: Free EBook and documentation generator

Layouts

Layout Formatting

The Layouts are the best way to customize the user's visual interface to any firing
system.

Saving and Loading of the layout files is done from a new Grid Options dialog. 

Make any changes in the view of the grid: Rearrange columns, hide or show columns, change
fonts and backgrounds.

http://www.helpndoc.com
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To save or load a grid layout, select the grid and press F11. 

Saving your grid layout will save: 
· The foreground and background colors 
· Fonts
· Columns shown (Hide/show)
· Column order and column width 

Loading will restore these values. Each type of grid (Script manager, Script Filter manager,
etc.) has its own layout file format and its file extension will be that of its grid + 'l'. 

For example, the Script manger's extension is '.scx' and its layout file extension is '.scxl'. 

Each layout file contains the layout for only one grid type. 

Layout files are not Project specific so you can load your layouts on any grid in any
project. 

Option to save or load all grid layouts at once.  Select from the menu Window->Window Layouts.  The
Layouts dialog will appear where you can select what loaded grids to configure and either Save or
Load those layout files.

Created with the Personal Edition of HelpNDoc: Produce Kindle eBooks easily

The Creation Process

The Creation Process

The Project

The creation of a Project (.pyr) is the first step to design a show.

The Project contains:
Two files for the appearance and display of the Grid and Tool bars.
·(.GRX) The Grid Preferences set for field colors, fonts, column display and position,
·(.ATB) The Toolbars settings for their display or not and position in the window

http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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These files are created automatically when the project is saved according to the
configuration that the user has made.
The files can be renamed in another project with the new project name and this will adopt
the configuration that they contain.

The Project contains and associates a group of files necessary to display a show: The
following files must be created or selected in this order to use the software.
·Wave File (.WAV)
Contains the music of the show to synchronize with cues.
·Script Manager (.SCX)
Contains the Cues and associated Effects characteristics, Positions, Worlds, Firing addresses.
·Visual Script (.CHR)
Contains a exported version of the Script used by the Viewer to run the simulation of the
show.
·Effects Manager (.EFX)
Contains the Effects with all the parameters necessary to be inserted in the cues of the
Script Manager.
·Position File (.POS)
Contains the Site positions. Created with the 3D Position Editor application.
·Library (.LIB)
Contains the Library of effects. Created with the FX Generator application.

The Project can also contain optional files not necessary to display a show but useful for the
operation of the Script Manager and Effects Manager:
·Script Filters (.SFR)
Contains a table of custom filters set by the user, to filter the Script in different ways and to
split the Script into various down-loadable tables to the Field Controller, and to Export the
cues according to the Filter selected.
·Script Sorts (.SSR)
Contains a table of custom Sorts set by the user, to sort the Script in different ways.
·Effects Filters (.EFR)
Contains a table of custom filters set by the user, to filter the Effects Manager in different
ways.
·Effects Sorts (.ESR)
Contains a table of custom sorts set by the user, to sort the Effects Manager in different
ways and to Export the cues according to the Filter selected.

Script and Effects Filters and Sorts can be associated in the Script or Effect View tool bar to
create a view that combines a filtered Script Manager or Effect Manager sorted in a specific
way.

For complete details in the VISUAL APPLICATIONS , please refer to their own User's Guide

Created with the Personal Edition of HelpNDoc: Free Kindle producer

Software User Folders Structure

Software User Folders Structure

It is recommended to create and maintain a logical folder structure that can be
shared with other users within a company and to store orderly the production show
files.

http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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You can start by using the same root drive C: or D:

In C: or any drive, create a root folder for the Visual Show Director software files.
The following is just an example. You decide what kind of order is best for you.

Example:

There will be common files used in every project: Effects Manager, Visual Libraries,
Sorts and Filters, Custom Reports,Layouts, Sites, Music,  that can be located in
dedicated folders as common shared resources.

If you create a Template project that will always open these common files, you will
need to add only Script and Wave, most likely.

In each specific project there will be files corresponding more exclusively to the project like:
Scripts,Sites, Reports... 

Created with the Personal Edition of HelpNDoc: Free Kindle producer

The Project

The Project File

The Project File

http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Show Director stores all information in Project files (.pyr). Project files linking the group of
files necessary to conduct the operation of show scripting and downloading to the Field
Controllers. 

You must always start by creating a Project, with the command New Project. If you
choose to not create a Project, you won't be able to save settings and layouts and
will be forced to open every time the group of files again.

Download the Visual Show Director Files structure Map

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Create a New Project

Create a New Project File (.pyr)

Start by creating a Project, with the command File Menu> New Project or press (Ctrl+N).

By creating a Project(.pyr) all of the necessary files for show design will be grouped together
and opened automatically each time the project is opened. If you choose not to create a
Project, you won't be able to save settings and will be forced to open the group of files
individually.

Once the Project is created you have to continue opening existing or creating new files in
order for them to be grouped: 
From the File Menu Create New:

Script Manager (.scx).
This is the window for scripting, containing the time-line and all the information of the show.
(create new, or open existing)

Effects Manager (.efx).
This is the window that contains your Database of Effects. You will insert effects or drag
them from this window into the Script. With this file it is NOT necessary to re-type effects in
the Script Manager every time you make an entry, if they are previously stored with all their
characteristics in the Effects Manager. You can have as many Effects Manager databases as
you want.

Wave Display (.wav).
This is the window that displays your music in the form of a PCM WAV file. You will navigate
through the Script and Music clicking on this display.
You will be able to insert cues or effects directly from here, and see a display of marks of
them in the wave display. The resolution of the display is adjustable. WITHOUT a .wav file,
cuing in times using cue function will not be possible as there is no reference of time without
the WAV. 

Sorts & Filters: Files that you create to change the view, organize, or arrange a Script
Manager(.scx) or Effects Manager(.efr) file. The purpose of using Sorts & Filters is to quickly
access and organize the vast amount of information contained in your show files. Create a
Filter and then enter in what parameters it will use to search, arrange, show or hide certain
data. 

newproject.html
http://www.infinityvisions.net/pdf/VSD_Map.pdf
http://www.helpndoc.com/help-authoring-tool
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Script Filter Manager (.sfr).
this window contains all possible Filter combinations for all columns that you create. This file
can be opened in multiple Projects, saving once in order to use your preferred filters at any
time. This window or control panel serves to create the Table files that will be downloaded to
the Field Controller. You can assign to each filter a Field Controller ID (serial number) and a
Firing Table ID. There is a Function to see the Unfiltered Cue, to avoid miss-download of
firing data. 

Script Sort Manager (.ssr). It contains allows you to create all possible combinations to
arrange the columns and rows. This file can be opened in multiple Projects, saving once in
order to use your preferred Sorts at any time. For example, arrange by Position, Effect,
Duration, Caliber. etc

Effects Filter Manager (.efr).
This window contains all possible Effect Filter combinations for all columns that you create.
This file can be opened in multiple Projects, saving once in order to use your preferred Filters
at any time

Effects Sort Manager (.esr).
This window contains all possible Effect Sort combinations for all columns that you create.
This file can be opened in multiple Projects, saving once in order to use your preferred Sorts
at any time.

Visual Script File (.chr)
Creates with a predetermined (given) name, normally the same as the Script Manager. This is
an exported version of the Script in .chr format used by the Viewer to run the simulation of
the show. The Export can be done by pressing the Icon with the yellow and black nuclear
sign on it.

Visual Position File (.pos)
Selects the Site positions. This file must be previously created with the 3D Position Editor
application accessed from the Tool bar.

Visual Library File (.lib)
Selects the Library of effects. The file must be previously created with the FX Generator
application accessed from the Tool bar.

If one or more of these files are missing, it will be impossible to start the viewer and the
system will warn you of the missing files.

Two new files that are created automatically in every Project are added to the group
of files in the Project. You should not delete or move these files:
·GRIDLAYOUT (.grx)
This file stores the configurations that you give to the Grids. In Show Director you can move
and swap the order of the columns and hide them.
·TOOLBARLAYOUT (.atb).
This file stores the layout of the new toolbars configuration and position in the window.
Every project can have different layout and configuration. Show Director will create a
specific GRIDLAYOUT (.grx) and TOOLBARLAYOUT (.atb), for every project. In the case that
you do not choose to work within a project, Show Director will create two default files.

Download the Visual Show Director Files structure Map

http://www.infinityvisions.net/pdf/VSD_Map.pdf


VISUAL SHOW DIRECTOR 8

39 / 119

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Open an Existing project

Open a Project File (.pyr)

It is only possible to have one project open at a time. If you open another project the
current one on screen will close. Changes are automatically saved. If you want to compare
Projects or Scripts you can launch the application as many times as necessary (conditioned
to RAM capacity) , multiple Show Director windows can be open at one time. 

When Show Director starts and you open a New Project, it will open with the default
configuration: all columns, black foreground and white background, MS Sans Serif 8 font. If
you open a new project with another one already open, the new project will adopt the
screen configuration of the existing one and will replace it. 

The Script and Effects Manager files will be the same as the previous project. Filters, sort
and download configuration will be the same. To open a project use the File Menu as shown
in the following illustration or the predefined shortcut CTRL-O.

http://www.helpndoc.com/help-authoring-tool
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Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Save a Project

Save a Project File

There are two ways to save a project.

Save Project: saves the Project and settings for the Grid and Toolbars and links to
associated files.

Save As:  saves the project with a different name, it is useful when you want to create a
new project with the same settings as the original. 
You may want to close and open new Script or other files.

Created with the Personal Edition of HelpNDoc: Full-featured Documentation generator

Close a Project

Close Project

File Menu > Close Project

http://www.helpndoc.com
http://www.helpndoc.com
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This command closes the Project and associated files. It frees the memory to open a new
Project without having the configuration of the previous Project.

Created with the Personal Edition of HelpNDoc: Full-featured Documentation generator

The Project Library

Project Library

File Menu > Project Library (Ctrl+L)

This command opens a new window, where you can see all the files associated with the
Project, and their relative paths.

You can Export these files packed, to a new Project, into a different directory or folder of
the original project.

This folder can be exchanged and when the exported Project opens in a different computer it
will keep the same layout configuration and file paths.

To export a Project the Project must be closed in order to be able to read and write new
files. Close the Project and Browse for it and then proceed to export.

For visual projects, exporting from the project library also exports textures and data for 3D
models as needed.

http://www.helpndoc.com
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In some cases the exporting of Sketchup models needs to be done manually copying from the
model folder. If you get an error message, uncheck the Visual Positions and proceed
manually.

· Import Project
Will import a previous version project into version 8 in a different new folder.

·"Write File List"
Will create a .txt document in the same folder of the project (.pyr), with the list of files and
paths. You can use this file to create a printed record of the Project files.

·"Export Project"
Will export a project with all its files in a specified folder. This function is useful to share
projects and to have portable copies.Will export a project in Show Director previous versions
file formats. 

·"Producer"
Will launch the Producer to render the visual project to a movie or picture format

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

The Wave file

The Wave File and Display WAV

http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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The Wave Display Window is the preferred way to script a show. You should be able to
create your soundtrack with a number of sound editors available on the market. Show
Director plays 16bit wave format. Wave Files made at 32 bit will need to be converted
to 16bit.

If you play the soundtrack from a .wav file, you will need to include time code in
synchronization with the wave clock. You can record time code from the Pyrodigital CD, the
time code starts at 00:00:00:00. If you are importing audio time code from the PD CD, do not
delete the tone at the beginning; it is part of the Time Code sequence.
From the .wav file with music and Time Code you can record your final show tape or vice
versa.

·The ability to display and script to the music's waveform image is now provided using the
WAV file display window. This display overlays the cues onto the WAV display, and indicates
each cue's caliber graphically with higher caliber being taller on the WAV display.

·The user has the ability to position the time cursor and add cues and effects using the WAV
display, in addition to the normal "space bar"� capture.

·The display appearance can be user defined under the Configure Menu- Wave Display.
You can select a .wav file to script.

File Menu > Wave File
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Before you open a wave file and want to see the graphics, make sure that you have
WAV Plot Display Enabled in the Configure Menu: Wave Display

Working Sequence:
1.Open Wave File Menu, select a wave file to play. Click Open in the Menu
2.The Process WAVE file window will be displayed. You can select left or right channel, if you
have a channel in your wave with the Time Code.

It is possible to increase the definition of the graphic display reducing the file size factor. The
graphic plot file size is by default 500 KB. The factor is set automatically to create a plot file
of this size. Bigger sizes of graphic plot file, will give more definition and also may slow the
display. Same size of Plot and Wave File is factor 1.

Channel selector allows selecting Left or right channels of your wave file. This is necessary
when you have a wave file that also has Time Code in one channel. To not plot the Time
Code Channel you will have to select the Music channel. The computer will play a wave file
as is, in stereo. To not hear the Time Code you will have to disable the channel with the
Windows audio settings for balance.
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Once the process of building the plot file is finished the new Wave Window will pop up and
will be synchronized with the Script. 
The cues and caliber will also be plotted over the wave graphic.

The commands in the Wave display window allow you to:

·Zoom In and Zoom Out (16 magnification steps) Small Scroll Left and Right Large Scroll Left
and Right Add a Cue pressing the Add Cue button or depressing the Space Bar Add a Cue
with a selected effect or effects in the Effects Manager while capturing. Visualize Marked
cues and caliber of effects Double click in any part of the wave graphic starts playing the
sound and re-locates the cue in the Script Manager Select a Cue or row in the Script
Manager places the Wave Cursor in the corresponding time position.

·To PLAY the music you can double click anywhere and the Script will locate the cue and
start playing and displaying the Events.

·If you are searching for a beat in the music, after locating it, you can use the right button
of the mouse to start play and stop in the same position.
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Multi-Select using Shift-Click on the Wave Plot will Select multiple cues.

When the Wave Plot is in Capture mode (i.e. "Green Light"), if you click on the wave plot it selects the next
nearest cue.  
Now if you Shift+Click further along the wave plot, it will multi-select all the cues between the two clicks.

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

The Visual Files

VISUAL FILES

In order to play a show in the Viewer, Visual Show Director needs to have a set of 3 files.

·A Visual Script File (.chr)
Creates with a given name, normally the same as the Script, an exported version of the
Script in .chr format used by the Viewer to run the simulation of the show. The file needs to
be Exported by pressing the Icon with the yellow and black nuclear sign on it.

·A Visual Position File (.pos)
Selects the Site positions. The file must be previously created with the 3D Position Editor
application.

·A Visual Library File (.lib)
Selects the Library of effects. The file must be previously created with the FX Generator
application.

If one or more of these files are missing, it will be impossible to start the Viewer and the
system will warn you of the missing files.

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

The Script File

The Script File

http://www.helpndoc.com
http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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The Script File (.scx) is where you create your show cues and contains all the information for
the show.
The functions that apply to the Script are in the Cues Menu. See the chapter Working with Cues

The Script window has the following columns names and characteristics:

* This is not a representation of the script, but a LIST of the variables in the Script.

You can reorder the position of the columns and have them visible  or hidden from the
interface.
Columns names can be changed in the Columns: Locks 1 to 8 and Custom6,7 and 8.

Data Field Formats

* When importing from .xls or .csv the number of characters will be trimmed to match Show
Director maximums.

Column Column Name Column Data Type Comment

1 CUE  Number(5) Unique id for a script row.

2 MACRO  Number(5) A number that links shots together for a single firing sequence. Event in Fireone.

3 GROUP  Text(48) Name of a group of effects.

4 TABLE  Text(32) Description to split the script into subscripts.

5 MODE  Text(32) MANUAL, MUSIC, AUTO or GPS.

6 TIME Number(8) Long value for PCM time.

7 HH  Number(2) Integer value for cue hours.

8 MM  Number(2) Integer value for cue minutes.

9 SS  Number(2) Integer value for cue seconds.

10 FF  Number(2) Integer value for cue frames (default 0-29)

11 MS  Number(7) Long value for total number of milliseconds represented by cue time.

12 NEXT  Text(8) MM:SS:FF until the next cue.

13 Event Description  Text(128) Open description of the event in the  cue.

14 PFT  Number(5) Pre-fire time in milliseconds.

15 ADDR  Number(3) Hex value for the Pyrodigital HEX address.

16 CONTROL  Text(32) Name of the field controller or system for this cue.

17 MODULE  Number(4) Integer address for a module (0-9999)

18 PIN  Number(4) Integer address for the pin on the module (0-9999)

19 CGHZ  Number(2) Integer 1-99 for Caliber hazard groups.

workingwithcues.html
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20 LOCK1  Text(10) Open lock description string. Character "X" activates lock.

21 LOCK2  Text(10) Open lock description string. Character "X" activates lock.

22 LOCK3  Text(10) Open lock description string. Character "X" activates lock.

23 LOCK4  Text(10) Open lock description string. Character "X" activates lock.

24 LOCK5  Text(10) Open lock description string. Character "X" activates lock.

25 LOCK6  Text(10) Open lock description string. Character "X" activates lock.

26 LOCK7  Text(10) Open lock description string. Character "X" activates lock.

27 LOCK8  Text(10) Open lock description string. Character "X" activates lock.

28 POS  Text(10) Firing  position. Alphanumeric.

29 ANGLE  Text(64) Angle is open text and may include numbers and \|/.

30 QTY  Number(4) Integer for number of effects on this cue.

31 CAL  Number(3) Integer value for the caliber of these effects in mm.

32 TYPE  Text(36) Text description of the kind or family of effect being fired.

33 DUR  Number(4) Integer effect duration in (0-99) seconds  and (0-29) frames (00:15 = 1/2 sec).

34 Effect Description  Text(128) Description of the effect. Color, etc.

35 REF  Text(50) Reference number for the effect.

36 MFG  Text(64) Manufacturer of the effect.

37 MAGAZINE  Text(6) Inventory Quantities. Inventory-tracking.

38 PRICE1  Number(8) Price of this effect.

39 PRICE2  Number(8) Price of this effect.

40 PRICE3  Number(8) Price of this effect.

41 CUSTOM1  Text(128) Open text field for effects data. Header right click to change.

42 CUSTOM2  Text(128) Open text field for effects data. Header right click to change.

43 CUSTOM3  Text(128) Open text field for effects data. Header right click to change.

44 CUSTOM4  Text(128) Open text field for effects data. Header right click to change.

45 CUSTOM5  Text(128) Open text field for effects data. Header right click to change.

46 CUSTOM6  Text(128) Open text field for script data. Header right click to change.

47 CUSTOM7  Text(128) Open text field for script data. Header right click to change.

48 CUSTOM8  Text(128) Open text field for script data. Header right click to change.

49 PAN  Number(255) Angle number value to describe PAN direction of trajectory .Multiple separated by " - "

50 TILT  Number(255) Angle number value to describe TILT direction of trajectory .Multiple separated by " - "

51 CAMERA  Text(255) Text field to describe the camera FOV. Captured from Viewer. "c" key.

52 VISUALREFERENCE  Text(255) Text field to describe the code of the particle effect. Fx Generator.
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53 BEAM  Text(255) Keyframing string for animation of lights and lasers. 3D POS EDITOR.

54 WORLD  Text(64) Text name of a site in the .pos project environment.3D POS EDITOR.

55 OBJECT  Text(255) Keyframing string for animation of an object in the 3d environment.

56 PICTURELINK  Text(255) Text link to PLAY a web or disk based picture.

57 VIDEOLINK  Text(255) Text link to PLAY a web or disk based video.

 

Version 8:
The Columns CUSTOM 1-2-3-4-5 and LOCKS 1-2-3-4-5-6-7-8 can be renamed with your own names.
Right Click in the Header of the column and do it the Form to Change name. Different names templates can
be saved and applied to new projects.

 

 

Created with the Personal Edition of HelpNDoc: Full-featured multi-format Help generator

Create a New Script File

Create a new Script File

File Menu > Script File > New

http://www.helpndoc.com/help-authoring-tool
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Creates a new Script file.

The user is prompted for a valid filename and, if the selected filename corresponds to an
existing file, the software warns the user and prompts for overwrite.

It is safe to press [NO] if the user doesn't want to overwrite the existing file.

Created with the Personal Edition of HelpNDoc: iPhone web sites made easy

Open an existing Script File

Open a Script File

File Menu > Script File > Open

http://www.helpndoc.com/feature-tour/iphone-website-generation
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Opens an existing Script file.

If the file that is being opened is from a previous version of Show Director, the software will
warn the user and will prompt for a filename for the imported version.

It auto-updates the file format.

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

Save Copies of the Script File

Save a copy of the current Script File

http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Saves a copy of the open File.

It is useful to frequently save backups of your file.

The current Script will close momentarily while saving and reopen.

Save the current Script File as an Effects Manager

You can create an Effects Manager from all the effects present in the Script. Just select
Effects Manager File in the Save As form.

Note: There is no [SAVE] command on Script as this is saved constantly every time a
change is made

Created with the Personal Edition of HelpNDoc: Generate EPub eBooks with ease

Import a Script File from other Firing Systems

Import a Script File from other Firing Systems

Imports a file from  Fireone (*.fir), Galaxis (*.gs2), Pyroleda (*.shw), Explo(*.shw), Cobra
and fireTEK (* .csv)

http://www.helpndoc.com/create-epub-ebooks
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The column order and configuration is the same as in Show Director Script. 

Created with the Personal Edition of HelpNDoc: Easily create PDF Help documents

Export a Script to other systems

Export a Script to other systems

Exports a file to Fireone (*.fir), Galaxis (*.gs2), Pyroleda (*.shw), Explo(*.shw), Cobra,
FIREMASTER, fireTEK (* .csv), Piromac.

The column order and configuration is the same as in Show Director Script. 

If you want to export All Columns, you need to use the File Menu function "Save As> Excel.
xls, or .csv"

FireOne Columns Correspondence (.xls)

FireOne F1 Type VSD Column Comment
ID AutoIncrementing AutoIncrementing - NOT CUE, CUE IS LOST
ScriptTime float
Position Char(10) POS DATA LOSS 64 -> 10
Qty small int QTY

http://www.helpndoc.com/feature-tour
www.infinityvisions.net/Documentation/GalaxisVSDExport.xls
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BreakTime float
Duration float DUR
Priority small int CGHZ Defaults to '1' else CGHZ
Cost BCD PRICE1
Location Char(8) POS DATA LOSS 64 -> 8
Comment Char(60) Event Description DATA LOSS 128 -> 60
LaunchTime float
Description Char(80) Effect Description DATA LOSS 128 -> 80
ProductNumber Char(20) REF DATA LOSS 50 -> 20
Size Char(12) CAL DATA CONVERSION  Int -> string
Color Char(14)
VendorNumber Char(20) MFG DATA LOSS 64 -> 20
Type Char(15) TYPE DATA LOSS 36 -> 15
ScriptTimeMS int MS
LaunchTimeMS int MS - PFT
DelayTimeMS int Hardcoded to '0'
ScriptTimeText Char(14) MS
LaunchTimeText Char(14) MS - PFT
DelayTimeText Char(14) Hardcoded to "00:00:00.00"
Effects Char(6) ANGLE DATA LOSS 64 -> 6
Event small int MACRO
Slat int MODULE
Cue int PIN
Length Int
SayWhen int
SayWhenText Char(14)
SayWhat Char(50)
Conflict Char(10)
PyroSlat Char(4)
PyroCue Char(2)

GALAXIS

Galaxis Columns Correspondence (.xls)

field - Version
2

Galaxis Name your
interpretatio

n

Prefered Galaxis Name VSD Column Comment Value Sample Sample Sample Sample Description

(Field #0) Ignition time count 0 Cue CUE starting with 1 1 - 999 Cue 1 starts normally at 00:00:00, if the ignition time is the same we
have the same cue number

(Field #1) Dt 1 dt NEXT as an integer representation of 1/100 seconds 0 - 99990 0,91s = 91 2,10s = 210
(Field #2) Ignition time 2 Fire Time MS - PFT as an integer representation of 1/100 seconds 0 - 3:55:49 = 35594 2:53:04 = 25304 9:57:75 = 95775 10:03:88 = 100388 the whole script is sorted by ignition time
(Field #3) Effect time 3 Effect Time MS - PFT  as an integer representation of 1/100 seconds 0 - same as ignition time
(Field #4) Prefire duration 4 PFT PFT in the format 0,00 0.00 - 1.55 = 1.55 2.20 = 2.20

5 Duration 1 DUR in the format 0,00 0.00 - 1.20 If you have a three times color changing effect = duration of effect 1

6 Duration 2 in the format 0,00 0.00 - 2.10 If you have a three times color changing effect = duration of effect 2

7 Duration 3 in the format 0,00 0.00 - 1.25 If you have a three times color changing effect = duration of effect 3

www.infinityvisions.net/Documentation/GalaxisVSDExport.xls
www.infinityvisions.net/Documentation/GalaxisVSDExport.xls
www.infinityvisions.net/Documentation/GalaxisVSDExport.xls
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(Field #8) Step cue 8 S Cue if two cues are to close together like < 0.30 s we have to use
the step cue and step delay

1 - 999

(Field #9) Step delay 9 S Delay  as an integer representation of 1/100 seconds 0.01 - 99.99 229.96 = 22996 431.46 = 43146
(Field #10) Category 10 Category as a string not really used
(Field #12) Effect Name 11 Item TYPE as a string

12 Description EFFECT DESC as a string Peony color changing free text for the user
(Field #13) Caliber 13 Size CAL as a string from VSD float 5 or 125 5 as inch or 125 as mm free value for the user

14 Effect 1 CUSTOM8 as a string Peony color changing free text for the user
15 Color 1 as a string red free text for the user
16 Effect 2 as a string Peony color changing free text for the user
17 Color 2 as a string blue free text for the user
18 Effect 3 as a string Peony color changing free text for the user
19 Color 3 as a string green free text for the user
20 Shots as an integer 16 Shots from a cake box 
21 Pcs QTY as an integer if you shoot more then one simultaneously

(Field #22) Launch Position 22 Position POS as a string left; center; right Firing position
(Field #23) Angle 23 Angle ANGLE Angle in degrees, followed by symbol font arrow characters dG, dF, and dH, e.g., up = 0dG , left = 0dF, right = 0dH with the PyrotecComposer.ttf font you can see an arrow in the right

direction and the value in degrees

24 Fan Type as a string free text for the user
25 Fan Name as a string free text for the user
26 Tube No. as a string free text for the user
27 Igniter as a string free text for the user

(Field #28) Device number 28 Device ID # MODULE ID number of the receiver, receiver 1 to 999 1 - 999
(Field #29) Output number 29 Output # PIN depends on the device and extension module like Matrix

Module 50 or 100 Output
1 - 100 (1 - 50)

(Field #30) SC-ID 30 SC-ID AutoCreated unique incrementing value + 10000 10001 -
31 DB-ID unique ID number of the database effect
32 Rising Height as a string free text for the user
33 Diameter as a string free text for the user
34 BAM Number CUSTOM1 as a string free text for the user
35 ADR Class. as a string free text for the user
36 UN Number CUSTOM2 as a string free text for the user
37 Chipher as a string free text for the user
38 Net weight CUSTOM3 in the format 0,00 free value for the user
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39 Gross weight CUSTOM4 in the format 0,00 free value for the user
40 S.D. horizontal in the format 0,00 free value for the user
41 S.D. vertical in the format 0,00 free value for the user

(Field #42) Product ID 42 Item No. REF as a string free text for the user
43 Supplier MFG as a string free text for the user
44 Producer as a string free text for the user
45 Price PRICE1 in the format 0,00 0.00 23.50 free value for the user
46 Calc. Factor PRICE2 in the format 0,00 0.00 1.40 we calculate Price (CP): 1.00 x 1.40 (Calc. Factor) = SP
47 Description CUSTOM6 as a string free text for the user
48 Information CUSTOM7 as a string nice effect free text for the user
49 Image (Path) PICTURELINK as a string free text for the user
50 Video (Path) VIDEOLINK as a string free text for the user
51 Indoor 0 or 1 free value for the user
52 Outdoor 0 or 1 free value for the user
53 C1 32 bit color value of Color 1 0 - 16777215 0 = black 255 = red 65280 = green 16711935 = magenta
54 C2 32 bit color value of Color 2 0 - 16777215 16777215 = white
55 C3 32 bit color value of Color 3 0 - 16777215
56 Infotext Z1 TYPE max. 16 characters  of ASCII Characters gerb step run Shows the PFC Advanced controller during firing
57 Infotext Z2 EFFECT DESC max. 16 characters  of ASCII Characters middle of stage Shows the PFC Advanced controller during firing
58 Class CUSTOM5 as a string
59 Stock Place MAG as a string
60 ShowSim Effect ID VISUALREF ShowSim Effect ID
61 Part List
62 F MACRO empty or F To separate the script; if the controller reads a "F" -> the controller

stops and wait till anybody press the fire button. Is sometimes used
with life music

63 Layer as a string
64 Group GROUP as a string the same name belongs to one group; just for editing
65 PAN Angle same as angle
66 Tilt Angle ShowSim TILT translated values for ShowSim from Angle
67 Pan Angle ShowSim PAN translated values for ShowSim from Pan Angle

FIREMASTER

Field Firemaster Name VSD Column Comment 
1 Cue Cue

2 Seq Macro

3 Rif Group

4 Start Cue Time Start + Delay = Cue Time, but Delay is not stored seperately

5 Delay (See Cue Time Comment)

6 Address Module / Pin If Unit/Term is provided it is used otherwise Address is split into Module/Pin

7 Unit Module

8 Term Pin

9 Group Cghz

10 Note Effect Description Up to 127 characters

11 11 - 17 UNUSED

EXPLO
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Field Explo Name VSD Column Comment 
0 Box/Nr MODULE / PIN The module (box) and pin (post) number of the shot.

1 Explozeit MS The break time of the shot, in the format 00:00.00. (MM:SS.MS)

2 Abstand Zündzeit NEXT The delay to the next firing row, in the format 00:00.00. (MM:SS.MS)

3 Effektbezeichnung Effect Desc The effect description.

4 Stz. PFT The prefire time, in the format 0,0 (comma decimal point).

5 Efz. DUR The duration of the effect.  Written as whole number of seconds

6 Efg. TYPE The effect category.

7 Stop

8 Stk. QTY Quantity.  total number of devices represented by the firing row.

9 Beschreibung ANGLE Comment. indicating the angles of the shots, such as ///.

10 Position "Position"

11 Steighöhe "Rising Height"

12 Größe CAL "Size"

13 Etk. CUSTOM8 Label text

14 Effekttop "Effect Top"

15 Gruppe GROUP "Group"

16 Bereich "Area"

17 Winkel TILT Angle.

18 Pos. POS Launch position.

19 (no name) REF  

20 blank Just to have an trailing TAB on each line

PYROLEDA

PyroLEDA Show Director Notes
“@” instruction line start character. GEH NOTE will skip all other lines
“cue”  (integer >0) cue id number.  GEH NOTE Autoincrements. if cue is

zero then we add a row with 0 time and this whole line in Event
Desc and the MACRO is zero

“time” MS - PFT  (integer >= 0) time in millisecond.
“trigger” MODE trigger source can be: MAN, AUTO, SLV
“group” CGHZ (integer >= 0 and <= 8) group id. GEH NOTE all values 8-16 will be

mapped to 8
“seq” MODULE  (integer > 0) sequencer id.
“fire” PIN integer > 0 (1-32) to turn on fire line, integer <0 to turn it off .  GEH

NOTE We can't do negitive pin numbers, see [length]
“fire comment” Event Desc  text string (can be null).
[“lenght”] Custom7 optional (can be omitted), integer>0 in milliseconds, duration of

pulse. Special value 32768 = infinite (line must be turned off
explicitly).  GEH NOTE: Stored in Custom7 as "LINE ON XX" or "LINE
OFF" if pin was negative

[“voltage”] Custom8  optional (can be omitted), integer>0 in Volt, if included, MUST BE
Forwarded by the preceding length field GEH NOTE stored in
Custom8

FIRETEK
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Field FireTek Name VSD Column Comment 
1 Module Address CONTROL

2 Slot Address MODULE

3 Pin Address PIN

4 IgnitionTime MS-PFT in milliseconds  (Prefire Time, MS - PFT)

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

Auto Restore - Undo

AUTO-RESTORE (UNDO)

· New Auto Restore for Scripts and Effects Managers. This new function will keep a back
up of your most recent Scripts or Effects Managers making a copy of the files every 5
minutes within 1 hour. There will be 12 copies that you can restore at any point on
time. 

· The feature is only active with a project open. The backup files are stored in a folder
inside the directory where the project is saved.The function can be manually
deactivated by changing On to Off in the file sd.ini in C:/Users/username/Appdata/
Roaming/ShowDirector. You will never loose more than 5 minutes of work.

Created with the Personal Edition of HelpNDoc: Generate EPub eBooks with ease

Scripting  for DMX

How to program different DMX devices from Show Director

Show Director supports DMX devices in two ways.  First by providing a simple way to address a DMX
controller, channel and value for that channel.  The second is by providing specific devices where multiple
channels are used.  Below we will provide example of how each can be used.
Show Director allows for DMX devices to be added to any show script.  Different actions can be specified
using the existing columns in your script.  One requirement for the DMX devices is that the TYPE column in

http://www.helpndoc.com
http://www.helpndoc.com/create-epub-ebooks
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your script must be exactly one of the supported DMX types.  For example, the SimpleDMX type must be
specified in the TYPE column as "SimpleDMX".  Case and spelling do count.  Other columns will contain
the additional information based on the DMX command.

SimpleDMX
The most basic of the DMX commands is a generic simple command.  This will set  one of the 512 channels
to a specified value.  We allow for CUSTOM1 column to be used to over-ride the PIN column.  This is so that
you can create Effects Manager entries to control the intensity value set to the PIN column.  If you put a
numerical value in CUSTOM1, it will over-ride the value in PIN.  Otherwise, use the PIN column.

SD Column Name DMX Note
TYPE Must be "SimpleDMX"
CONTROL Controller One DMX controller universe per serial USB

connection
MODULE Channel Values 1 to 512 are allowed
DUR The duration that this channel will

have this value before returning to
zero

If duration is zero (00:00) then the channel is
set to value permanently, otherwise max
duration is 99 seconds

PIN or CUSTOM1 Value to place on the Channel Values 0 to 255 are allowed.

Here is an example of what a SD script might look like using SimpleDMX commands:
CU
E

HH MM SS
FF

TYPE CONTRO
L

MODUL
E

DUR PIN Event Description

1 00  00  00 
00

SimpleDMX C1 12 01:15 255 Turn channel 12 on for 1
and a half sec

2 00  00  05 
00

SimpleDMX C1 7 00:00 127 Set channel 7 to 127

3 00  00  10 
15

SimpleDMX C1 7 00:00 0 Set channel 7 to 0

When the DUR column is zero, then the value place on the channel is permanent until changed again by
another cue.  However, if a duration is provided, then the channel is set to the value in the PIN column for
the specified time and then the channel is returned to zero.  The limit on duration is 99 seconds.

Galaxis G-Flame Flame Box
One of the specifically supported DMX devices is the G-Flame by Galaxis.  Like most flame boxes, the G-
Flame has a safety channel as well as a trigger channel.  In order for the G-Flame to operate, the safety
channel must first be turned on and later, for safety, must be turned off.  The G-Flame therefore has three
command: GFlameSafetyOn, GFlameTrigger and GFlameSafetyOff.  These can be called multiple times
during the show as long as the safety channel is on before any event triggers.  Note that multiple G-Flame
devices can share a single safety channel.  Here are the SD columns and an example script:

SD Column Name DMX Note
TYPE One of the GFlame commands listed below
CONTROL Controller One DMX controller universe per serial USB

connection
MODULE Channel Values 1 to 512 are allowed
DUR The duration of this flame Must be a value between 00:01 and 25:00

(maximum duration)

Assuming two G-Flame boxes are configured with safety channel 33 and trigger channel 2 and 17
respectively:
CU
E

HH MM SS
FF

TYPE CONTRO
L

MODUL
E

DUR Event Description

1 00  00  00 
00

GFlameSafetyO
n

G2 33 00:00 Set channel 33 to GFlame safety
value

2 00  00  05 
00

GFlameTrigger G2 2 00:15 Flame on device 2 for half sec
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3 00  00  05 
00

GFlameTrigger G2 17 00:15 Also start device 17 for same

4 00  01  00 
00

GFlameTrigger G2 2 05:00 Flame on device 2 for 5 sec

5 00  05  00 
00 

GFlameSafetyOf
f

G2 33 00:00 Disable both 2 and 17

You should always turn the G-Flame safety on for at least 1 second before any trigger events in order to give
the flame box time to get activated.

Le Maitre Salamander Flame Box
The Salamander Flame Box is a specifically supported DMX device.  Like all flame boxes it has a safety
channel and a trigger channel.  In order for the flame box to operate, the safety channel must be turned on
before any trigger commands will activate.  For safety reasons we must also turn the safety channel back off
at the end of the script.  The safety and triggers may be turned on or off any number of times as long as the
safety is on before any trigger cues are executed.  The Salamander has three commands for this:
SalamanderSafetyOn, SalamanderTrigger and SalamanderSafetyOff.  Note that multiple Salamander devices
may use the same safety channel.

SD Column Name DMX Note
TYPE One of the Salamander commands listed below
CONTROL Controller One DMX controller universe per serial USB

connection
MODULE Channel Values 1 to 512 are allowed
DUR The duration of this flame Must be a value between 00:01 and 25:00

(maximum duration)

Here is an example SD script using two Salamander flame boxes with separate safety channels.  One has
the safety channel on 1 and trigger on 2, the other safety is 3 and trigger 4.

CU
E

HH MM SS
FF

TYPE CONTRO
L

MODUL
E

DUR Event Description

1 00  00  00 
00

SalamanderSafetyOn C1 1 00:00 Set channel 1 to Salamander
safety value for device 2

2 00  00  00 
00

SalamanderSafetyOn C1 3 00:00 Set channel 3 to Salamander
safety value for device 4

3 00  00  10 
00

SalamanderTrigger C1 2 00:15 Flame on device 2 for half sec

4 00  00  10 
00

SalamanderTrigger C1 4 00:15 Also start device 4 for same

5 00  01  00 
00

SalamanderTrigger C1 2 05:00 Flame on device 2 for 5 sec

6 00  05  00 
00 

SalamanderSafetyOff C1 1 00:00 Disable channel 1 for 2

7 00  05  00 
00 

SalamanderSafetyOff C1 3 00:00 Disable channel 3 for 4

You should always allow for 10 seconds after turning the Salamander safety channel on before any trigger
events.

Explo X2 Wave Flame Box
The Explo X2 Wave flame box is specifically supported by SD.  This DMX device sports a moving flame head
and is a little more complex the some other flame boxes.  SD takes care of this complexity through four
commands: X2WaveSafetyOn, X2WaveTrigger, X2WaveSeq and S2WaveSafetyOff.  The X2 Wave device has
a safety channel for each device and they cannot be shared.  A unique feature of the X2 Wave is that you
only need to set the first channel of the device.  All other features are an offset from that first channel and
therefore not required to be specified in the SD script.  There are 6 channels in use, so the base addresses
for any other device must be 6 greater than the base address of the X2 Wave.  If the base channel of a X2
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Wave flame box is 6, then the next DMX device on the controller must be set to 12 or higher otherwise you
will have channel conflicts and errors.

SD Column Name DMX Note
TYPE One of the GFlame commands listed below
CONTROL Controller One DMX controller universe per serial USB

connection
MODULE Channel Values 1 to 512 are allowed
DUR The duration of this flame Must be a value between 00:01 and 02:15

(maximum duration)
TILT Angle of the flame head 0 degrees is horizontal right, 90 is up and 180 is

horizontal left.  Negative values may be used
between 0 and -180 to represent down (-90 is
down).  

CUSTOM2 Speed of flame head When the flame head changes positions, the
speed at which if moves may be specified.  0 is
stationary, 1 (slowest) to 255 (fastest).  Default
movement is fastest.

REF Built-in X2 Wave sequences There are 70 built in sequences programmed into
the X2 Wave.  See the X2 Wave user's manual for
a full explanation of these sequences.

Here is an example SD script using the X2 Wave.  Assume we have two devices set to base channel 10 and
16 respectively.

CUE HH MM SS FF TYPE CONTRO
L

MODUL
E

DUR REF TILT CUSTOM
2

Event Description

1 00  00  00 
00

X2WaveSafetyO
n

DD1 10 00:0
0

Set safety on for device 10

2 00  00  00 
00

X2WaveSafetyO
n

DD1 16 00:0
0

Set safety on for device 16

3 00  00  10 
00

X2WaveTrigger DD1 10 00:1
5

Flame on device 10 for half
sec

4 00  00  10 
00

X2WaveTrigger DD1 16 00:1
5

Also start device 16 for
same

5 00  01  00 
00

X2WaveTrigger DD1 10 02:0
0

Flame on device 10 for 2 sec

6 00  01  30 
00

X2WaveTrigger DD1 10 00:0
0

135 255 Flame off, move head to 45
left

7 00  01  00 
00

X2WaveTrigger DD1 10 02:1
5

45 127 Flame on med wave to 45
right

8 00  01  00 
00

X2WaveTrigger DD1 10 00:0
0

90 255 Flame off move to up

9 00  01  00 
00

X2WaveTrigger DD1 10 02:0
0

Flame on device 10 for 2 sec

10 00  01  00 
00

X2WaveSeq DD1 10 00:0
0

51 Seq med wave 45 left to 45
right

11 00  01  00 
00

X2WaveSeq DD1 16 00:0
0

52 Seq med wave 45 right to 45
left

12 00  05  00 
00 

X2WaveSafetyO
n

DD1 10 00:0
0

Disable device 10

13 00  05  00 X2WaveSafetyO DD1 16 00:0 Disable device 16
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00 n 0

The build in sequences in the X2 Wave are nice in that cue 10 does the same thing as cues 6,7 and the
duration of the flame is regulated by the sequence, not by the script writers estimation.

SafeX Flame Jet Flame Box
The SafeX Flame Jet flame box is another SD supported DMX device.  Like all flame boxes it has a safety
channel and a trigger channel.  In order for the flame box to operate, the safety channel must be turned on
before any trigger commands will activate.  For safety reasons we must also turn the safety channel back off
at the end of the script.  The safety and triggers may be turned on or off any number of times as long as the
safety is on before any trigger cues are executed.  The Flame Jet has three commands for this:
FlameJetSafetyOn, FlameJetTrigger and FlameJetSafetyOff.  Note that multiple Flame Jet devices may use
the same safety channel.

SD Column Name DMX Note
TYPE One of the Flame Jet commands listed below
CONTROL Controller One DMX controller universe per serial USB

connection
MODULE Channel Values 1 to 512 are allowed
DUR The duration of this flame Must be a value between 00:01 and 10:00

(maximum duration)

Assuming two Flame Jet boxes are configured with safety channel 33 and trigger channel 2 and 17
respectively:

CU
E

HH MM SS
FF

TYPE CONTRO
L

MODUL
E

DUR Event Description

1 00  00  00 
00

FlameJetSafety
On

G2 33 00:00 Set channel 33 to FlameJet safety

2 00  00  05 
00

FlameJetTrigger G2 2 00:15 Flame on device 2 for half sec

3 00  00  05 
00

FlameJetTrigger G2 17 00:15 Also start device 17 for same

4 00  01  00 
00

FlameJetTrigger G2 2 05:00 Flame on device 2 for 5 sec

5 00  05  00 
00 

FlameJetSafety
Off

G2 33 00:00 Disable both 2 and 17

You should always turn the Flame Jet safety on for at least 1 second before any trigger events in order to
give the flame box time to get activated.

CRGBLight
A very common DMX controlled light is one with four channels that does Red, Green and Blue colors.  Show
Director Control has provided a TYPE for this light.  The Control for the light is in the PIN (or CUSTOM1)
column and is light specific as to how values control the light.  Typically 0 turns the light off and 255 will use
the values of Red, Green and Blue to set color and intensity.  Your lamp may have other features that are
controlled using the PIN column.  Consult your manual.  To specify a color, you need to have the start of the
Effect Description have a '#RRGGBB' hexadecimal value.  These values are two hex characters each for red,
green and blue.  So, for example, #FF0000 would be full red.  #00FF00 would be full Blue, etc.  #7F0000
would be half intensity red.  #00FFFF would be bright cyan.  If you provide a duration, the light will turn on for
than amount of time and then turn itself off.

SD Column Name DMX Note
TYPE Must be "CRGBLight"
CONTROL Controller One DMX controller universe per serial USB

connection
MODULE Channel Values 1 to 512 are allowed.  Each

CRGBLight uses 4 contiguous channels. 
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Next device must be 4 higher than the value
used here.

DUR The duration that this channel will
have this value before returning to
zero

If duration is zero (00:00) then the channel is
set to value permanently, otherwise max
duration is 99 seconds

PIN or CUSTOM1 Control value to place on the
Channel

Values 0 to 255 are allowed.  Typically 0 is
off and 255 uses the color and intensity
provided.  Other values are light specific
features like blinking and fade.

Effect Description Color and Intensity of the light Values #000000 to #FFFFFF are allowed

Here is an example of what a SD script might look like using CRGBLight commands:
CU
E

HH MM SS
FF

TYPE CONTRO
L

MODUL
E

DUR PIN Event Description

1 00  00  00 
00

CRGBLight C1 1 01:15 255 #FFFFFF bright white for
1.5 seconds

2 00  00  05 
00

CRGBLight C1 1 00:00 255 #FF0000 full red on

3 00  00  10 
15

CRGBLight C1 1 00:00 255 #A5184C switch to
custom color

4 00  00  12 
15

CRGBLight C1 1 00:00 0 Turn light off

PanTiltWRGBCYMLight
Another common DMX controlled light is one with 10 channels that does Pan, Tilt, colors.  Show Director
Control has provided a TYPE for this light.  In this light, the color is determined by an internal color wheel
that has 7 colors: White, Red, Green, Blue, Cyan, Yellow and Magenta.  To specify a color, you need to
have the start of the Effect Description have a '#RRGGBB' hexadecimal value.  These values are two hex
characters each for red, green and blue.  So, for example, #FF0000 would be full red.  #00FF00 would be full
Blue, #00FFFF would be bright cyan, etc.  If you provide a duration, the light will turn on for than amount of
time and then turn itself off.  In addition the light has a swivel head and can be panned or tilted.  You can
pan through 360 degrees and tilt from 0 to 180.  The light can be pan/tilted while the light is off or on.

SD Column Name DMX Note
TYPE Must be "PanTiltWRGBCYMLight"
CONTROL Controller One DMX controller universe per serial USB

connection
MODULE Channel Values 1 to 512 are allowed.  Each

PanTiltWRGBCYMLight uses 8 contiguous
channels.  Next device must be 8 higher than
the value used here.

DUR The duration that this channel will
have this value before returning to
zero

If duration is zero (00:00) then the channel is
set to value permanently, otherwise max
duration is 99 seconds

PIN or CUSTOM1 The intensity of the light Values 0 to 255 are allowed.  0 is off through
255 being full intensity.

Effect Description Color of the light Values #000000 to #FFFFFF are allowed.
PAN Pan angle of the light Values 0-360.
TILT Tilt angle of the light Values 0-180.
CUSTOM2 Speed of the pan and tilt Values 1-255.  1 is slow, 255 is fast.  Zero or

blank is fast.

Here is an example of what a SD script might look like using PanTiltWRGBCYMLight commands:

CU
E

HH MM SS FF TYPE CONTRO
L

MOD DUR PIN PA
N

TIL
T

CUSTOM
2

Event Description
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1 00  00  00 
00

PanTiltWRG
BCYMLight

C1 7 01:1
5

255 #FFFFFF bright w hite for
1.5 seconds

2 00  00  05 
00

PanTiltWRG
BCYMLight

C1 7 00:0
0

255 90 45 127 #FF0000 full red on, pan
90 and tilt up 45, medium
speed

3 00  00  10 
15

PanTiltWRG
BCYMLight

C1 7 00:0
0

255 135 255 #A5184C sw itch to
custom color and tilt over
to 135, fast speed

3 00  00  12 
15

PanTiltWRG
BCYMLight

C1 7 00:0
0

0 0 0 Turn light of f  and return
to center pan and tilt, fast
speed
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Scripting Commands and Syntax of Visual Columns

Scripting Commands and Syntax of Visual Columns

There are special syntax for each of the following Column fields:

QTY

PAN & TILT

CAMERA

VISUAL REFERENCE

BEAM

WORLD

OBJECT

VIDEO LINK & PICTURE LINK

Created with the Personal Edition of HelpNDoc: Easily create EPub books

QTY

Script Commands and Syntax: QTY FIELD

QTY

This field contains an integer that can be 0 or not. If 0 is the value no effects will be
displayed. To shoot the effects 1 must be at least present. 0 will not fire.
The number of effects shot in the engine is not determined by the QTY value but by the
number of angles present in the PAN and TILT fields whatever is greater. (for example, if
three angels 60-90-120 is entered into the TILT Column, three shots will be fired) 3 must be
entered into QTY solely for inventory purposes. The QTY field should always reflect the total
number of effects for inventory purposes.

Other fields: PAN & TILT - CAMERA - VISUAL REFERENCE - BEAM - WORLD - OBJECT -
VIDEO LINK & PICTURE LINK

http://www.helpndoc.com/help-authoring-tool
http://www.helpndoc.com/feature-tour
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Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

PAN & TILT

Script Commands and Syntax: PAN & TILT

PAN AND TILT

This fields contain integer values separated by the - character. Their number determines the
number of effects to shoot and the angles.
If PAN angles are not used, the field can be left empty. Only TILT angles will be taken into
consideration.

PAN is the rotation around Y axis (orientation), and TILT is the rotation around Z axis
(inclination).
Normally the X axis is pointing to the right of the audience view and it represents 0 degrees.
Angles are set counter clockwise 180__|90|__0

The previous versions ANGLE field is not used to fire the effects but only as a reference. It
admits also symbolic characters like \|/.

Examples:

Example I:

PAN TILT

45-90 90

It specifies 2 effects to be shot; the three effects will have the
following pair of angles for shooting:

First effect: PAN=45, TILT=90
Second effect:PAN=90, TILT=90

Example II:

PAN TILT

0 45-90

It specifies 2 effects to be shot; the two effects will have the
following pair of angles for shooting:

First effect:PAN=0, TILT=45
Second effect:PAN=0, TILT=90

Example III:

PAN TILT

0-45 0-45-90

It specifies 3 effects to be shot; the three effects will have the
following pair of angles for shooting:

First effect:PAN=0, TILT=0
Second effect:PAN=45, TILT=45
Third effect:PAN=45, TILT=90

http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Example IV:

PAN TILT

0-45-90 45-60-75

It specifies 3 effects to be shot; the three effects will have the
following pair of angles for shooting:

First effect: PAN=0, TILT=45
Second effect:PAN=45, TILT=60
Third effect:PAN=90, TILT=75

Other fields: QTY - CAMERA - VISUAL REFERENCE - BEAM - WORLD - OBJECT - VIDEO
LINK & PICTURE LINK

Created with the Personal Edition of HelpNDoc: Easily create EBooks

CAMERA

Script Commands and Syntax: CAMERA

CAMERA

The camera reference is obtained by pressing the letter �c� in the keyboard while window
focus is in the Viewer and then pasting it into the Visual Reference field of the Script with
the mouse right button menu, Paste Selection.

The Camera contains the following string:
camera(-25.500000*1744.199707*-4560.000000*358.980011*3.060000*0.000000*60*1)

camera(x*y*z*rx*ry*rz*fov*time)     FOV:Field of View ( lens angle)

Where:

·x,y and z are the coordinates of the new positions of the camera.

·rx,ry and rz are the rotation angles of the camera.

·fov is the field of view angle, in this case 60 degrees opening. Human Eye FOV is 120.

·time is the transition time, in milliseconds, for the camera movement. The minimum value is
1.

·Cameras can be copied and pasted as regular cues.

·To set a camera transition from one point of View to another, two camera codes are
necessary. The first code will be the origin point and the second the destination.
 
·The transition start time is determined in a cue following at least 1 frame of script time from
where the origin code was pasted. This new line will contain the new destination code.The
duration of the transition is set in the second (or destination code) at the last digit for time.

·The sign # in front of the camera code cancels a camera action, so it is not necessary to
delete the code, while rehearsing a position.

# camera(-25.500000*1744.199707*-4560.000000*358.980011*3.060000*0.000000*60*1)

http://www.helpndoc.com/feature-tour
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Other fields: QTY - PAN & TILT - VISUAL REFERENCE - BEAM - WORLD - OBJECT - VIDEO LINK
& PICTURE LINK

Created with the Personal Edition of HelpNDoc: Easily create HTML Help documents

VISUAL REFERENCE

Script Commands and Syntax: VISUAL REFERENCE

VISUAL REFERENCE

The Visual reference code is obtained with the VSD FXGenerator, it contains the name of
the effect and its variations in color, size and height. It is a necessary field to display the
effect.

This field has the following syntax:
shoot(Chrysanthemum*0000FF-FFFFFF-FFFFFF*0*0)
shoot(effect name *color string *opening radius*height)

Where:

·Effect name is the name of the effect to be shot.

·Color string is the color string for the effects; it must be written with the following
Hexadecimal color syntax:
RRGGBB-RRGGBB-RRGGBB
where R, G or B is any hexadecimal digit from 0 to F corresponding to the decimal value of
the color.

Example:
White = FFFFFF,
Black = 000000,
Red = FF0000,
Green= 00FF00
Blue=0000FF

To understand Hex colors Read This

The color string can be modified directly, without the use of the FXGenerator, if a set
of colors and hexadecimal values are known.

·Opening and height are the alternative opening radius and height for the effects. Opening is
only relevant for the Shell effect types, not for Ground effects.

Other fields: QTY - PAN & TILT - CAMERA - BEAM - WORLD - OBJECT - VIDEO LINK &
PICTURE LINK

Created with the Personal Edition of HelpNDoc: Free HTML Help documentation generator

BEAM

Script Commands and Syntax: BEAM
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BEAM ( lighting & lasers and image projections)

The beam reference is built inside the VsdPos3D and can be exported (copied to the
clipboard) from inside the VsdPos3D by right-clicking and selecting Export key-framing string.

The string code has the following syntax:

beam(300*1*Z90*1*0*300*Y0*1*0*300*X0*1*0*300*CFFFF80*1*FFFF80*300*O1*1*1*3
00*D5*1*5*300*L150*1*150*300*B100*1*100*300)

beam(duration*number of repeats*initial z angle*number of
angles*angle1*time1*...*angleN*timeN*initial y angle*number of
angles*angle1*time1*...*angleN*timeN*initial x angle*number of
angles*angle1*time1*...*angleN*timeN*initial color*number of
colors*color1*time1*...*colorN*timeN*initial start diameter*number of start diameters*start
diam.1*time1*...*start diam.N*timeN*initial final diameter*number of final diameters*final
diam.1*time1*...*final diam.N*timeN*initial length*number of
lengths*length1*time1*...*length N*timeN*initial brightness*number of
brightnesses*brightness 1*time1*...*brightness N*timeN)

The values of the string are based in the Modifiers values set in the VSDPOS. An initial cue
can have a complete number of modifiers and a following one can just have one modifier.

Due to the length and complexity of the strings it is better to modify the values in the
VSDPOS and export the string.

If you want you can also make modifications directly in the string. Here is an example:

beam(300*1*Z90*1*0*300*Y0*1*0*300*X0*1*0*300*CFFFF80*1*FFFF80*300*O1*1*1*3
00*D5*1*5*300*L150*1*150*300*B100*1*100*300)

Beam (duration (300)*repetition count (1)*Z90*1*0*300 stands for: Z initial is 90, there is 1
change, 0 is the next Z value, 300 is the transition time*and so on for the others... *C is
color *O is start diameter*D is final diameter*L is length*B is brightness)
The letter represents the beam property... Z,Y and X are the beam angles... B is the
brightness, O and, L is length, and...
After the letter, there is always the initial value so Z90 means that the initial Z value is 90,
and so on for the other letters
The number after the * is the number of transitions
Then, after this number, there are couples of numbers *N*T where N is the new value of the
beam property and T is the transition time
for example: CFFFF80*1*FFFF80*300 means that the initial color is FFFF80... then the color
changes one time, in particular the new color will be FFFF80 in 3 seconds

Lengths of the beam can be adjusted 
L150*1*150*300 means that the initial length is 150, then the length changes one time, in
particular the new length will be 150 in 3 seconds

Other fields: QTY - PAN & TILT - CAMERA - VISUAL REFERENCE - WORLD - OBJECT -
VIDEO LINK & PICTURE LINK

Created with the Personal Edition of HelpNDoc: Produce Kindle eBooks easily

WORLD

Script Commands and Syntax: WORLD
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WORLD

The position file project  (.pos) can have multiple Sites with different models or pictures. In
this case the WORLD field must contain the name of the Site to display. It is possible to
change in a cue from one WORLD or Site to another by changing the Site name in the WORLD
column. The Script will change to that WORLD when the cue is shot.

When there is only one Site. The Viewer by default will open that site only. No input in the
WORLD field is necessary. As soon as there is another site in the Position File, input of
specific sites is necessary.

Other fields: QTY - PAN & TILT - CAMERA - VISUAL REFERENCE - BEAM - OBJECT -
VIDEO LINK & PICTURE LINK

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

OBJECT

Script Commands and Syntax: OBJECT

OBJECT

The Object field is used to control the animation of the objects inside the models or the
sites. An object with an attached effect can rotate around itself, like a Saxon, or it can
move across the site, like a boat.

The Object reference is built inside the VsdPos3D and can be exported (copied to the
clipboard) from inside the VsdPos3D by right-clicking and selecting Export key-framing string.

The syntax is the following:

object(Ellipse_4x_I1*1*1*2000*0*1*0*0*720*0)
object(name of the object*1*1*time*0*1*0*0*total rotation angle*0)

The string code can be copied and pasted and the Object manually renamed to do the same
operation for similar objects.
The Duration time in milliseconds can be adjusted. In this case is 2000 or 2 seconds, but the
value can be altered to increase or decrease the duration of the movement.
The Total rotation angle can be increased or decreased or change the direction by inserting
a negative number. Positive number is clockwise direction, and negative (-720) is counter
clockwise.

If we change as:
object(Ellipse_4x_I2*1*1*10000*0*1*0*0*-1440*0)
In this case the object is a similar one, number I2 ,will rotate during 10 seconds and 4 times
around itself (4x360=1440).

Other fields: QTY - PAN & TILT - CAMERA - VISUAL REFERENCE - BEAM - WORLD -
VIDEO LINK & PICTURE LINK

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

VIDEO LINK & PICTURE LINK

http://www.helpndoc.com/help-authoring-tool
http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle


VISUAL SHOW DIRECTOR 8

70 / 119

Script Commands and Syntax: VIDEO LINK & PICTURE LINK

PICTURE LINK

This field is used to link pictures to the effects. Normally these are set in the Effects Manger.
The pictures will be used to render a synchronized to cues slide show with the PRODUCER
option.
The pictures are not displayed in the Viewer, only in the final rendered movie.

VIDEO LINK

This field is used to link video clips to the effects. Normally these are set in the Effects
Manager.
The video clips will be used to render a synchronized to cues slide show with the PRODUCER
option.
The video clips are not displayed in the Viewer, only in the final rendered movie.

Other fields: QTY - PAN & TILT - CAMERA - VISUAL REFERENCE - BEAM - WORLD -
OBJECT

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Working with Cues

Working with Cues

Show Director offers a wide number of functions, options and choices that work with the
Script Manager.

From the [CUES] menu the following functions are available:

http://www.helpndoc.com/help-authoring-tool
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·Save New Cues
·Clear New Cues

·Copy Cues
·Cut Cues
·Paste Cues
·Duplicate Cues
·Insert Cues
·Insert Effects
·Create Effects
·Update Effects
·Create Macro

·Capture Cues
·Renumber Cues
·Renumber Addresses
·Validate Addresses
·Reset Addresses
·Offset Time
·Refresh Grid
·Column Fill Down
·Cues Invert
·Cues Auto Complete
·Locate

·Import Cues
·Export Cues
·Import Beat
·Export .chr

Created with the Personal Edition of HelpNDoc: Full-featured multi-format Help generator

Save / Clear New Cues

SAVE / CLEAR New Cues

While capturing cues in play mode , if you want to keep the cues, you can save them
instantly before stopping, or clear them if you do not want to keep them.

This command is active only when Play is running. Once you stop playing the cues are

http://www.helpndoc.com/help-authoring-tool
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automatically inserted in the Script.

Created with the Personal Edition of HelpNDoc: Free help authoring tool

Copy, Cut, Paste and Duplicate  Cues

COPY / CUT / PASTE / DUPLICATE

You can copy or cut any selection on the Script and paste it in any other cue or selection of
cues with automatic time reset to the inserted cue.

With Visual Show Director you can Copy selections of cues at different times and Paste them
in different cues or selections of cues at different times.

First: make a Selection.
If you don't know how to select multiple cues, please refer to Selection Strategies

To Copy Press Ctrl+C, select command from Menu or click the related Icon in the toolbar

To Cut Press Ctrl+X, select command from Cues Menu or click the related Icon in the
toolbar. Cut will take off the cues from the Script and store them temporarily in the
Clipboard

To Paste Make first a selection of one or Multiple Cues. Press Ctrl+V, select command from
Cues Menu or click the related Icon in the toolbar.

to Duplicate Press Ctrl+D, select command from Cues Menu or click the related Icon in the
toolbar.
When you are duplicating more than one time, a cue that is part of a group of cues
with the same time, make sure that after duplicating it, the cursor always moves
back to the first cue, which may be a different effect than the one you want to
duplicate. To avoid this problem:
·Use Copy Paste commands, or
·Create a sort named �Duplicating� with Time as value 1 and Cue as value �2
(descending). The last cue duplicated will go up and be selected, and you will be able
to continue with the duplicate operation.

You can now also Copy, Cut and Paste text within cells or from other application.
Highlight the text string and, clicking on it with the right button of the mouse, opens
the edit Menu.

Created with the Personal Edition of HelpNDoc: Easily create iPhone documentation

Insert Cues

INSERT CUES

This is a powerful Show Director feature that you can use with great flexibility. It is a real
time saver.
At the same time it is a calculator of cue intervals, numbers, within time sequences.

http://www.helpndoc.com/help-authoring-tool
selectionStrategies.html
http://www.helpndoc.com/feature-tour/iphone-website-generation
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How to use Insert Cues

·Go to Cues Menu and select Insert Cues, or just type Ctrl+I

·The Insert/Edit cues window will open.
You can use this window to Insert any number of cues, with a selected effect, address, position and Interval
of firing.

Time/Duration

·Set the time in in Frames or Milliseconds.
·If after Apply you wan to continue insert cues at the last cue entered, select Update. The Script will scroll
to the last row and you can create a new sequence.

There are 3 methods of operation.

o Compute # of Cues: You can select a Time in and a Timeout for the effect and interval. Show Director
will calculate the number of cues necessary.

o Compute Interval: You can select a Time in and a Time-Out and the number of cues. Show Director
will calculate the interval in-between cues.

o Compute Duration: You can select a Time in, the number of cues and the interval. Show Director will
calculate the Time Out.

To any of these methods you can assign:

The selected effect or effects in Effects Manager. Or type a REF and the effect will be automatically
selected.
A position. If you want to create a sequence of position incremental (In) or  decremental (Dec) check
the corresponding box.
A Quantity. 
A Description for Event DEscription column.
An  angle Tilt and  Pan
A Macro Number or Event (Fireone)
Caliber Group Hazard number, and an Event Description.
Correlative or offset addresses, in HEX and DEC ( module and Pin)

To select multiple effects in the Effects Manager, press the Shift key for adjacent effects in the list or the
Ctrl key for non-adjacent and descending effects selected. The multiple effects selected will be inserted with
the same time, and as many times as the number of cues at the selected intervals. After filling the values on
the form, you can press the Compute button to see the results, and adjust if necessary any of the values.
Clicking Apply or OK buttons inserts the cues in the Script window. 

How to Insert One Single empty line

Just press the Ins key in your keyboard below the cue time you want to insert.

WATCH VIDEO TUTORIAL

https://youtu.be/7DXnPHMg0GQ
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Insert Effects

INSERT EFFECTS

(See also Duplicate Cues)

The same functions as Duplicate cues apply for Insert Current effect.
In the Effect Manager, select a single effect, subsequent effects, or a nonadjacent selection
of effects (See also Selection Strategies).
You can also select multiple cues, and insert the effect or effects in each cue of the multiple
selections.

Select contiguous rows with the Shift key.
Select alternate roes with the Ctrl key.

In the Script Window:

·Select the row(s) at the time(s) where you want to insert the selection,
Select contiguous rows with the Shift key.
Select alternate roes with the Ctrl key.

·Press Ctrl-E, select command from Cues menu or click in the Icon.

·All the effects selected will be inserted with the same time.
In the script window you can type a reference number or the first digits of it in the Script
window Reference field and you will see how it is located in the Effects Manager, and also
inserted in the Script.

·Once you have the desired effect.
Press Ctrl+E and the effect(s) will be inserted at the selected cue(s).

If you want to work within a specific category of effects, apply a filter to the Effects
Manager, and the same functions will apply.

http://www.helpndoc.com/feature-tour
selectionStrategies.html
selectionStrategies.html
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Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

Create Effects

CREATE EFFECTS

You can create a new effect entry in the Effects Manager by selecting the effects in the
Script and selecting Create Effect from the Cues Menu.

A window will pop up with the following message:

New effect lines will be created in the Effects Manager fro all the effects not already
present.

It is necessary to have a distinct  reference number for each effect. REF.

This function is particularly useful when you have a Script that was created without and
Effects Manger, by typing each effect manually.

Created with the Personal Edition of HelpNDoc: Easy EBook and documentation generator

Update Effects

UPDATE EFFECTS

All or a selection  of Cues Effects data in a script can be updated from  a new the  loaded  Effects Manager.
If you  have updated your  Effects Manager with new information, you can quickly update your Script by REF
number  with  the new data.  
Make a  selection of Cues (or no  selection for the full script) and select from the menus Cues->Update
Effects.

Add Script Effect to Effects Manager

If a Cues REF number is not in the current Effect Manager, it can be automatically added with all the
provided effect data by selecting the cue and selecting from the menus Cues->Create Effects

Created with the Personal Edition of HelpNDoc: Write EPub books for the iPad

Create Macro

CREATE MACRO

Select a cue with a CGHZ value other than zero and select from the menus Cues->Create Macro. 

http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
http://www.helpndoc.com
http://www.helpndoc.com/create-epub-ebooks
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For the current script view, all cues with the matching CGHZ value will be tallied and their Cue Time will
be set to the value of the highest value.  

However, all of the PFT values will be set so that the original cue time is kept.  

That is to say that a macro with the correct fire times will be created based on PFT and the highest cue
time. 

Macros are limited to a total of ten minutes time.  After that you will need to break them down into
separate macros.

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Capture Cues/Automatic Beat Detection

CAPTURE CUES
    

To start capturing cues the Capture Cues function must be on.
You can do that from the Cues Menu, pressing F2 or clicking in the Streetlight Icon.

When the streetlight icon is on �Green� and in the bottom bar it says �Capture On�, you
are ready to capture Cues.

The CD and WAV file players have been enhanced to allow the "seek to" operation.
The user may seek both forward and backward in increments of 5 seconds. Also, by selecting
a row in the event grid and pressing the Play key the music will seek to that time and begin
playing. This greatly enhances the ability to quickly review firing sequences.

The Clock on the second left box at the bottom of the screen displays a HH: MM: SS: FF
clock in sync with the Time Code.

> Press Space-bar, or Click Add Cues on the Wave Display button.
You can also insert selected effects at the same time that you capture cues pressing the
Button Add Effects. The Effects Manager needs to be open to have this function enabled.
Each time you press, the New Cues box displays the total of cues entered, and the Last Cue
pan the time of the last cue. You can see that the Script window displays the new cues with
the <CAPTURE> sign in the Event Description column. The columns HH: MM: SS: FF display
the exact time of the cues.

> Stop playing the music.

The Script Window will update and save automatically the cues entered. You can also save
the cues at any moment during capture by going to the Cue menu and clicking on Save Cues.
To review the cue markers in the wave Display you need to PressF8

> Rewind, and Play again. Capture must be ON to play the cues.

The Next cue on the time sequence will be highlighted in blue, and as the cues time match
the Time Code running clock they will highlighted as well. The Blue highlight is programmed to
be stable at the center of your window. Therefore at the beginning of the script it will scroll
down to find the center position of the screen, and at the end will move down until the last
cue is highlighted.

500 cues may be safely captured before being saved.

If you want to enter a modification or adjustment in the time HH: MM: SS: FF, you can do it
by selecting the cell and typing a new number. Press Tab to go to the next cell. It is also

http://www.helpndoc.com/help-authoring-tool
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possible to increase or decrease the time value by Pressing (Shift +) to increase, or, (-) to
decrease (no Shift).

Music Beat Detection and Cue Insertion

a. Often you need to insert a large set of cues that are on the beat of the music.  Show
Director now includes Beat Detection for doing this.  With a wave file loaded and the
Capture mode off (i.e. "Red Light") , click where you want the capture to start and Shift
+Click where you want the capture to stop.  If you don't set a starting and/or ending point it
will use the beginning and end of the wave plot.  Select from the menus Cues->Import
Beat...  This will bring up the Beat Detection dialog:

b. Onset Sensitivity is how sensitive the detection is.  If you have more sensitivity you get
more cues, possible including false beats or back beats.  Less sensitive you might miss a
few beats ins quiet sections or if the beat gets too complex.  Play with this setting to get
the level you want.

c.
NOTE: Some .wav files, like those converted from .mp3, may not be able to be beat detected due to not
having the correct PCM internal format.  We will work on this for a future update.

Watch Video Tutorial

Created with the Personal Edition of HelpNDoc: Create iPhone web-based documentation

Renumber Cues

RENUMBER CUES (F3)

Selecting Renumber Cues in the Cues menu or pressing F3 will renumber the cues in the
entire script or filtered script.

Warning: There is no Undo for this function. Use Restore Backups.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Renumber Addresses

RENUMBER ADDRESSES (F4)

Show Director allows you to address your script with an important degree of automation and
verification.You won't need to type every single address.

http://www.infinityvisions.net/wp-content/uploads/2015/07/VSD830-WHAT-IS-NEW.mp4
http://www.helpndoc.com/feature-tour/iphone-website-generation
http://www.helpndoc.com/feature-tour
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It is possible to address for multiple firing systems. Pyrodigital uses the ADDR column based
on hexadecimal address from 000 to 7FF. 
Other systems use Module and Pin. Module from 000 to 999 and Pin from 0 to 100. Control
can be used for systems that use a Controller or a module with also multiple Slats and Pins. 

You need to know the Sort, Filter, and Selection strategies, to use the Renumber Address
function to its full potential.

Normally to address a script you will do it with a Sort by positions, then by caliber, then by
quantities, then by Tilt (angle), then by time or product type. 
If you want your show to be progressively fired by time and fire your racks in a spatial
sequence, you will sort by time (this way you add a safety factor, as in the case of having
to go to the launching site during firing, you know where there are no shells to be fired). If
for packing reasons you want to load by type of product you will then sort by product.

If you want to keep this Addressing Script separate from the Time Script, you can copy and
save it with another name with Explore. 

To start addressing then, Sort by Position (POS), then by Caliber (CAL), then by Time (HH:
MM: SS: FF), and then by Type-Effect Description or Reference. 

SHOW DIRECTOR can sort and filter by different categories and apply the combinations to a
Script View.

Once you have your Script sorted, you can either address all of it at once, or do it by blocks
based on Filters.

For all the Script:
· Select the cell where you want to start in the ADD or Module and Pin columns. Type

the initial address, ex 010. or 1 and 1 and press Enter. 
· Go to Cues Menu and select Renumber Address or Press F4. The form Renumber

Addresses will pop up.

· Pin Range on the module for ADDR (in Hex)
You can set the pin range to fill the modules. If you want to leave some free

scriptsortfile.html
scriptfilterfile.html
selectionstrategies.html
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addresses you can type Min 0 and Max D. In this case the moudule wlil be filed until
address C. Any range between 0 and F is possible.

· Module address range and Pin range in the module( for Decimal:)
Select the star module number from 1 to 999 maximum.
Select the Pin range from 1 to 999 , or 1 to 32, or whatever the module can handle.

· Increment CONTROL:
This feature is used to address different Controllers when a limit of modules set in
above parameters is exceeded. 
Or to address a module that has multiple Slats and Pins per Slat. It will change the
Control Module number after 4 Slats and 12 pins per slat have been used.

· Addressing Conditions. Incrementing Decrementing Pin:
You can address in any order starting a module from F to 0 or from 32 to 1, or from
100 to 1, etc.
Reset Address when CONTROL changes will restart the counting from the minimum
to the maximum.

· Increment modules when a sort condition changes:
This is one of the most powerful features of this control. You can automatically
change to a new module when a positions changes or when a caliber or when multiple
conditions are met.

· Autonumber by POS

Tallies up all the POS values and them supplies module and pin addresses by POS.  From the
existing Renumber dialog (Cues->Renumber Addresses), notice the new checkbox for Auto
Address by POS only.

Select this option, which will disable other Addressing Conditions, and renumber.

After you have finish addressing you can see a Module Report.
In the module report you can see what pins in each module are used or not.
and a total count of the modules and which modules belong to each Controller.
You can save a .xls or .txt file of this report.
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Created with the Personal Edition of HelpNDoc: Free iPhone documentation generator

Validate Addresses

VALIDATE ADDRESSES (F5)

Once the script addressing is done, you can validate your Script checking for repeated
addresses.

You can do it now within the application before downloading to the Field Controller.

·Go to Cues Menu
·Select Validate Addresses, or press F5.
A window for Duplicate Address Error will pop up, indicating any duplicate addresses or none
(No duplicate addresses).

   

If any Address is duplicated , the message indicates the Cue number and the Address
duplicated, and at the same time highlighted on the script window the row with the
error.
Click OK. Go to the address cell, change it, and press Enter.

For SAFETY reasons you must validate the Script.
Addresses 000 to 00F, sometimes used for comments, are not excluded on the check.
Show Director does not allow entering any addresses over 7FF.

If you want to keep duplicated addresses:

http://www.helpndoc.com/feature-tour/iphone-website-generation
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·Click Skip button, at the error prompt

Created with the Personal Edition of HelpNDoc: Full-featured EBook editor

Reset Addresses

RESET ADDRESSES (F6)

Reset addresses, changes all the addresses to HEX 000 or DEC Module 0 and Pin 0.

This is useful when importing a script from an old show that has addresses on it and needs to
be re-addressed.
Instead of deleting one by one you can do it all at once.

Created with the Personal Edition of HelpNDoc: Write EPub books for the iPad

Offset Time

OFFSET CUES (F7)

The Offset feature is necessary when the Time code has changed from your original script or
if you want to move a group of cues in the timeline.

Created with the Personal Edition of HelpNDoc: Write EPub books for the iPad

Refresh Grid

REFRESH GRIDS (F8)

Refresh grid command sorts the script by the current options set in the Sort Menu.
By default the sort is by Time-PFT-Cue.

http://www.helpndoc.com/create-epub-ebooks
http://www.helpndoc.com/create-epub-ebooks
http://www.helpndoc.com/create-epub-ebooks
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Refresh also computes and adds new values for the NEXT column, and updates the Price 1-
2-3 sum.

It also updates the markers on the wave display, if any.

Refresh is necessary to refresh the Viewer file, when new cues with effects in the Script or
Visual files have been updated.

Created with the Personal Edition of HelpNDoc: iPhone web sites made easy

Column Fill Down

COLUMN FILL DOWN (F9)

If you want to copy, repeat a value to the following cues, you can use the Fill Down
command.:

1.Select the cell you want to fill down.

2.While pressing the Shift key, select the last row of your fill. The selection is highlighted.
Use Ctrl key to make non contiguous selections. (for more information: Grid Selection
strategies)

3.Press F9, and the cell will be copied to the cells below the selection

Note: If you skip the point number 2, the cell will be copied until the end of the visible
part of the script (sorted and filtered, in other words, it will fill until the end of the
grid).

Created with the Personal Edition of HelpNDoc: Free HTML Help documentation generator

Cues Invert

INVERT CUES (CTRL+SHIFT+F9)

If you want to invert the values of a column or a whole set of cues, you can use the INVERT
CUES command:

To Invert only the content of ONE column:

1.Select the first cell you want to invert in the desired column.While pressing the Shift key,
select the last row in which you want to invert the content. The selection is highlighted.

2.Press CTRL+SHIFT+F9, and the selected columns content, of the selected rows, will be
inverted

To Invert a whole set of rows content (all but the time):
1.Select the first row you want to invert.While pressing the Shift key, select the last row in
which you want to invert the content. The selection is highlighted.
2.Press CTRL+SHIFT+F9, and the all the rows, except Time, are inverted.

http://www.helpndoc.com/feature-tour/iphone-website-generation
selectionStrategies.html
selectionStrategies.html
http://www.helpndoc.com
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This function really helps in creating fans and reverse sequences.
See Video Tutorial Here.

Created with the Personal Edition of HelpNDoc: Full-featured Documentation generator

Cues Auto Complete

CUES AUTO-COMPLETE (CTRL+F9)

This new function auto-completes sequences of positions, angles and any column you want.
AutoComplete can be used also in the Time columns HH MM SS FF MS and NEXT to create
time intervals and sequences.

The logic of the auto-complete function

This function, is based on the user input. It finds the increment gap in your sequence and
goes to fill the rest

·if you are using it on the Address field and the first cell is A01 and the second is B01, it will
keep addressing with C01, D01 and so on
·if you are using it on the Address field and the first cell is A01 and the second is C02, it will
keep addressing with E03, G04 and so on

This function is useful to create angles and addresses sequences. Note: the sequence is
calculated on the first two cells of the selection.

To auto Fill a column

1.Select the first cell you want to use as the base of the sequence.While pressing the Shift
key, select the last row in which you want to auto Fill. The selection is highlighted and the
first two cells of the selection are used to create the sequence.

2.Press CTRL+F9, and the selected columns content, of the selected rows, will be filled
automatically by the auto-complete function

See Video Tutorial Here.

Created with the Personal Edition of HelpNDoc: Easily create EBooks

Locate

LOCATE (F10)

Locate helps you to go to a certain Cue, Time or Address of the Script. When you have to
make changes in the addresses of the script, you should use this command. You will be able
to locate the address and change it to a new one

https://youtu.be/9Hfo1yQkcSo
http://www.helpndoc.com
https://youtu.be/9Hfo1yQkcSo
http://www.helpndoc.com/feature-tour
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Import / Export Cues

IMPORT AND EXPORT CUES

This is one of the most powerful functions of Show Director. You can use it to create
macro scripts and design sequences that you can easily add to any new script.

Import and Export cues Show Director feature works together and in conjunction with Script
Filter Manager option.

A Filter is a part of the Script.
It could be a large number of cues corresponding to a song, or several cues for a particular
sequence.
The filter can be more specific than only cues.
You can filter by any entry in the Script. If you want to use a song without certain positions,
calibers or products, you can filter it.

EXPORT FILTERED CUES:
1.First create a Filter name in the Script Filter Manager. Make the selection of values for
every column.
2.Select the Filter in the Drop down menu. The Script will show only the Filtered Cues.
3.Select Export Cues in the Cues Menu or click in the Icon
4.Follow directions in the Save Menu. A new Script file will be created for the Filtered Cues.
Once you have exported the cues or you have another script you can use and import in
different projects.

IMPORT FILTERED CUES:
1.Select the Cue or Cue Selection where you want your Script (filtered)
2.Select Import Cues in the Cues Menu or click in the Icon
3.Choose the File to Import
4.The imported Script with cues will be inserted in the Cue or in every Cue of your selection.

Created with the Personal Edition of HelpNDoc: Write EPub books for the iPad

Import Beat

http://www.helpndoc.com/feature-tour/iphone-website-generation
http://www.helpndoc.com/create-epub-ebooks
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IMPORT BEAT

Wave
1. Multi-Select using Shift-Click on the Wave Plot will Select multiple cues.

a. When the Wave Plot is in Capture mode (i.e. "Green Light"), if you click on the wave plot it
selects the next nearest cue.  Now if you Shift+Click further along the wave plot, it will
multi-select all the cues between the two clicks

2. Music Beat Detection and Cue Insertion
a. Often you need to insert a large set of cues that are on the beat of the music.  Show

Director now includes Beat Detection for doing this.  With a wave file loaded and the
Capture mode off (i.e. "Red Light") , click where you want the capture to start and Shift
+Click where you want the capture to stop.  If you don't set a starting and/or ending point it
will use the beginning and end of the wave plot.  Select from the menus Cues->Import
Beat...  This will bring up the Beat Detection dialog:

Onset Sensitivity is how sensitive the detection is.  If you have more sensitivity you get
more cues, possible including false beats or back beats.  Less sensitive you might miss a
few beats ins quiet sections or if the beat gets too complex.  Play with this setting to get
the level you want.
NOTE: Some .wav files, like those converted from .mp3, may not be able to be beat
detected due to not having the correct PCM internal format.  We will work on this for a
future update.

Created with the Personal Edition of HelpNDoc: Easily create EBooks

Export .Chr (Visual Script File)

EXPORT .CHR

.chr file is used by the Viewer graphic engine and it is a copy of the script.
By default it is created and exported every time you refresh the grid by pressing F8.

It is a good strategy to export it manually if you can't see the script changes reflected in the
visual components.

Created with the Personal Edition of HelpNDoc: Free help authoring environment
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The Script Filter File

The Script Filter File

Filtering will cause the Script file to show&hide certain data. For example, if the Script
contains two field controllers FC1 & FC2 the Script can be Filtered for only one of the field
controllers, in this case FC1. After being filtered, the script will only display cues to be shot
by FC1 and the newly filtered Script can therefore be quickly available to load into the
Controller. This way the show can be designed on One single table.

It contains all possible Filter combinations for all columns that you can create.
This file can be opened in multiple Projects, saving your preferred filters for future use. This
window or selection panel serves to create the Table files that will be downloaded to the
Field Controller. You can assign to every filter a Field Controller ID (serial number, labels..)
and a Firing Table ID.

There is a Function to see the Unfiltered Cue, to avoid miss-download of firing data.

Steps in Creating a Filter

NAME: In this field you enter the name of the Filter. This will become the name of the Firing
Table file (.tab), if you assign a value in the FC ID and FT ID columns. The names of the
Filter will be displayed in the Drop-Down Toolbar

FC ID: (FIELD CONTROLLER IDENTIFICATION).
In this filed you enter the number of the Field Controller. It can be any number, no letters.
You can put the Serial Number to identify the FC if you want. In the Download Manager (see
later: Firing Tables Manager) you can select each FC with the display of the Tables assigned
to it.

FT ID: (FIRING TABLE IDENTIFICATION).
In this field you put the number of the Firing table assigned to the Field Controller. The values
are hexadecimal, as are in the Firing Tables. Therefore, you can enter up to 12 Tables, from 0
to B. The program won�t let you enter a value superior to B.

COLUMN FIELDS:
The Columns in Green or Red are Ranges:
·FIELD in Green corresponds to IN value.
·FIELD in Red corresponds to OUT Value.

If values remain at 0, the range is not taken into consideration.

Sorts and Filters Selection: When you select a name in the Drop-Down menu the Script will
change accordingly to the settings of the Filter.

You can select the Sort and Filter directly from the  Script or Effects Sort & Filter
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Managers. Select/highlight the row and press enter will change the view of the Script or
Effects Manager, and it will be reflected in the drop down boxes where you previously had to
do the selections.

Script Filter Manager AutoCreate

You can now automatically create a set of Effect Filters based on column data from Effect
Manager.  Select a column in Effect Manager then in Effect Filter Manager double-click the
empty FilterName cell.  You can also AutoCreate with two neighboring 
Columns selected for a compound effect. A dialog will ask if you wish to AutoCreate the
filters, select Yes.  

A set of Filters will be created based on the column or columns you selected and the column
data that matches at least one row in your Effect Manager.  

Filter Word based.
You can create a filter based in a single word or description. Name the Filter and Shift Double
Click in a cell containing the description. A dialog will ask you if you want to add that
description to the filter selected. Once included in the Filter you can delete the part of the
Description that you don't need and leave just the word. You can also type the word directly
in a Filter column.

Partial Match on Filters 
For Script and Effect Sorts, all text fields now will match case-insensitive on a partial sort. 
If, for example, you have a Sort for Description that is "Yellow" it will find all Descriptions with
the word "Crackling" or "crackling" or “CRACKLING".

Easy Add to Script- Effect Filter Manager
When you have a row selected in Script-Effect Filter Manager and you press Shift-Double
Click in a cell in the Script- Effect Manager, you will be asked if you wish to add that cell
data to the selected filter. Yes will add the data into the correct cell, No will go into normal
Edit for the cell. 
For the Columns VISUALREFERENCE, VIDEOLINK and PICTURELINK that have links to the Test
Viewer, Video Player or Website, to view the linked effects, just double click to view. Other
Show Director Changes
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Script filter File Operations

The Script Filter File Operations

From the File Menu, the following functions are accessible for the Script Filter File

·NEW
Creates a new file (it prompts for overwriting if the selected file exists)
·OPEN
Opens an existing file
·SAVE AS...
Saves a copy of the open File. It is useful to frequently save backups of your file.
·CLOSE
Closes the opened file

Created with the Personal Edition of HelpNDoc: Free help authoring tool

The Script Sort File

The Script Sort File

This is very important for organizing the firing Table. Normally the Script is chronological, a
Sort File will help to arrange the Script based on other parameters. For example, The Script
can be arranged in order of Position, Caliber, Quantity, Tilt, Reference. This allows the Script
to be sorted such that Addressing of shots can be done automatically!!!

This contains all possible Sort combinations for all columns that you wan to create. This file
can be opened in multiple Projects, saving once your preferred sorts for future use.  All
columns of the Script Manager are present in the Script Filter Manager.

You need to give a name to the Sort and then proceed to insert the values of your Sort
Order.
Value 1, will be the first column sorted, and so on. Positive values sort Ascending. Negative
values sort Descending.
The display order of the columns in the Script Sort Manager, will change accordingly to the
sort order, to help you visualize the Sort.

http://www.helpndoc.com/help-authoring-tool
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The Sort names will be displayed in the Script View Tool-bar:

When you select a name in the Drop-Down menu the Script will change accordingly to the
settings of the Sort.

Sorts and Filters Selection 
You can select the Sort and Filter directly from the  Script or Effects Sort & Filter Managers.
Select the row and press enter will change the view of the Script or Effects Manager, and it
will be reflected in the drop down boxes where you previously had to do the selections.

Quick and Additive Sort

1. Quick Sort by using the three new tool-bar buttons, Sort Ascending, Sort Descending and Clear
Sort.  Select a column that you want to be your primary sort.  Press either the Sort Ascending or
the Sort Descending button

2. If you select additional columns and presses either the Sort Ascending or Sort Descending buttons
it will add additional levels of sorting.  To clear the quick sort, press the Clear Quick Sort button.

3. Apply multiple Script or Effects Filters
a. Selecting one or more Script Filters or Effects Filters and Right Clicking will apply all filters

selected.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Script Sort File Operations

The Script Sort File Operations

From the File Menu, the following functions are accessible for the Script sort File

·NEW

http://www.helpndoc.com/feature-tour
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Creates a new file (it prompts for overwriting if the selected file exists)
·OPEN
Opens an existing file
·SAVE AS...
Saves a copy of the open File. It is useful to frequently save backups of your file.
·CLOSE
Closes the opened file

Quick Sort by using the three new Tool bar buttons, Sort Ascending, Sort Descending and Clear Sort. 
Select a column that you want to be your primary sort.  Press either the Sort Ascending or the Sort
Descending button

If you select additional columns and presses either the Sort Ascending or Sort Descending buttons it will
add additional levels of sorting.  To clear the quick sort, press the Clear Quick Sort button.

Apply multiple Script or Effects Filters

Selecting one or more Script Filters or Effects Filters and Right Clicking will apply all filters selected.

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

Script Views

Script Views

A Script View is a combination of a Sort and a Filter.

You can name the View for quick access with the Drop-Down Menu in the Toolbar.

This is useful to view parts of the Script (Filters) sorted in a particular Order.

You will find many useful applications for this feature.

There is a limit of 32 names for Views in a Project.

Created with the Personal Edition of HelpNDoc: Create iPhone web-based documentation

The Effects Manager

The Effect Manager File

Effect Manager (Effect Filename.efx) is the Show Director products database.

Show Director can open simultaneously only one Effect Manager and one Script at a time.
You will be able to create as many Effect Manager databases as you want, for different products and show types, and bring

http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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them up as you need, but only one at a time.
Each Effect Manager has unlimited Filters available. (See Effect Filter later). You can have a complete database that is filtered
by any category of the column Fields.
You can create an Effect Manager File, from scratch, from another Effect Manager File via Filtering and Export, or import from a
.csv file created with Excel, Access or any database/spreadsheet application.

EXCEL
You will also be able to export a Show Director Effect file (. efx) to a same (.efx) file (see Effect Filter later- Export Effects) or a
(.csv)(.xls) formats to be opened with your spreadsheet application for more complex editing or presentation.

To see what is the format of a .csv or .xls, Open a new Effects Manager and then save it as .csv or .xls. 
Open it in Excel and use the same format of columns. 
Add your data an reopen the file with Show Director

EFFECTS MANAGER FROM A SCRIPT
It is possible to create an Effects Manager from the products used in a show.
Open the Script, and Save As .efx.
An Effects Manager with the single individual effects used will be created.

Version 8
The Columns CUSTOM 1-2-3-4-5 Can be renamed with your own names. Right Click in the Header of the column and do it the Form to Change name.
Different names templates can be saved and applied to new projects.

 
The Effects File

Data Field Formats

* When importing from .xls or .csv the number of characters will be trimmed to match Show Director maximums.

The Script window has the following columns and characteristics:

 

Column Column Name Column Data Type Comment

1 CAL  Number(3) Integer value for the calibar of these effects 

2 TYPE  Text(36) Text description of the kind or family of effect
being fired

3 PFT   Number(5) Pre-fire time in miliseconds

4 Effect Description  Text(128) Description of the effect

5 DUR  Number(4) Integer effect duration in frames and seconds
(100 = 1 sec)

6 REF  Text(50) Reference number for the effect

7 MFG  Text(64) Manufacturer of the effect

8 MAGAZINE  Number(6) Inventory Quantities.

9 PRICE1  Number(8) Price of this effect

10 PRICE2  Number(8) Price of this effect
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11 PRICE3  Number(8) Price of this effect

12 CUSTOM1  Text(128) Open text field for effects data

13 CUSTOM2  Text(128) Open text field for effects data

14 CUSTOM3  Text(128) Open text field for effects data

15 CUSTOM4  Text(128) Open text field for effects data

16 CUSTOM5  Text(128) Open text field for effects data

17 VISUALREFERENCE  Text(255) Text field to describe the name of the particle
effect

18 BEAM  Text(255) Text field description of lights and lasers

19 PICTURELINK  Text(255) Text link to a web or disk based picture

20 VIDEOLINK  Text(255) Text link to a web or disk based video

 

·AUTO-RESTORE (UNDO)
·New Auto Restore for Scripts and Effects Managers. This new function will keep a back up of your most recent Scripts or Effects Managers making a
copy of the files every 5 minutes within 1 hour. There will be 12 copies that you can restore at any point on time. The feature is only active with a
project open. The backup files are stored in a folder inside the directory where the project is saved.The function can be manually deactivated by
changing On to Off in the file sd.ini in C:/Users/username/Appdata/Roaming/ShowDirector. You will never loose more than 5 minutes of work.



VISUAL SHOW DIRECTOR 8

94 / 119

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Create a New Effects File

Create a new Effects Manager File

http://www.helpndoc.com/feature-tour
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Creates a new Effects Manager File.

The user is prompted for a valid filename and, if the selected filename corresponds to an
existing file, the software warns the user and prompts for overwrite.

It is safe to press [NO] if the user doesn't want to overwrite the existing file.

Create a new Effects Manager File from the Script

With a Script open you can create an Effects Manager file of all the individual effects present
in the Script. 
Go to Script Save As and choose .efx

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

Open an existing Effects File

Open an Effects Manager File

Opens an existing Effects Manager File.

If the file that is being opened is from a previous version of Show Director, the software will
warn the user and will prompt for a filename for the imported version.

It auto-updates the file format.

http://www.helpndoc.com
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Open and eff

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Open and Save Effects  Managers in .csv .xls .efx

Import an Effects Manager File from a .CSV or .XLS File 

The importing of an Effects manager in .csv or .xls format is done from the File Menu / Effect File / Open
Menu.
Imports a .csv or .xls file from Excel or any application supporting the file format. 

The column formats must be the same as in Show Director Effects Manager. The order of the
column does not matter.

The column names must be the same as in Show Director but not in the same order. 

See the format of the Columns in The Effects Manager 

http://www.helpndoc.com
http://www.infinityvisions.net/doc_vsd/theeffectsmanager.html
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Working with Effects

Working with Effects

Show Director offers a wide number of functions, options and choices that work with the
Effects Manager.

From the [EFFECTS] menu the following functions are available:

·

·Refresh Grid
·Duplicate Effects
·Column Fill Down
·Locate Effect Ref #
·Total Effect
·Total All Effects
·Update Effect Totals...
·Import Effects
·Export Effects
·Merge Effects

Created with the Personal Edition of HelpNDoc: Easily create EPub books

Refresh Grid

REFRESH GRIDS (Shift+F8)

Refresh grid command updates the Effects Manager Grid.

http://www.helpndoc.com/create-epub-ebooks
http://www.helpndoc.com/feature-tour
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Please refer to the analogue function of the Script Manager for more information.

Created with the Personal Edition of HelpNDoc: Free EPub producer

Duplicate Effects

DUPLICATE EFFECTS

First: make a Selection.
If you don't know how to select multiple rows, please refer to Selection Strategies

Press Ctrl+A, select command from Effects Menu or click the related Icon in the tool-bar.

You can now also Copy, Cut and Paste text within cells or from other application.
Highlight the text string and, clicking on it with the right button of the mouse, opens
the edit Menu.

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

Column Fill Down

COLUMN FILL DOWN (Shift+F9)

If you want to copy, repeat a value to following effects, you can use the Fill Down
command.:

1.Select the cell you want to fill down.

2.While pressing the Shift key, select the last row of your fill. The selection is highlighted.

3.Press Shift+F9, and the cell will be copied to the cells below the selection

Note: If you skip the point number 2, the cell will be copied until the end of the visible
part of the effects file (sorted and filtered, in other words, it will fill until the end of the
grid).

Created with the Personal Edition of HelpNDoc: Easily create PDF Help documents

Locate Effect Ref#

LOCATE (Shift + F10)

Locate helps you to go to a certain effect based on reference #

http://www.helpndoc.com/create-epub-ebooks
selectionStrategies.html
http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
http://www.helpndoc.com/feature-tour
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Total Effect

TOTAL EFFECT (F12)

This is an inventory-tracking feature.
In order to operate properly you need to assign the Columns MAGAZINE in the Script Manager
and Effects Manager to display the total quantities on hand or inventory for each product.

To know at any given moment of scripting the quantities of a particular product in the
script :

·Select the product in the Script

·Select the command in the Effects Menu, Press F 12 or click the Icon.

If you have used more quantities than available in inventory the display in MAGAZINE /Script
Manger will show negative numbers.

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Total All Effects

TOTAL EFFECT (F12)

This command extends the inventory account to all the products in the Script Manager.

Please refer to Total Effect function for more information.

Created with the Personal Edition of HelpNDoc: Free iPhone documentation generator

Update Effect Total

UPDATE EFFECT TOTALS (CTRL+F12)

The Effect Manager can be updated by Subtracting all the product from the selected Script,
which causes a NEW Effect File to be created.

http://www.helpndoc.com/feature-tour
http://www.helpndoc.com/help-authoring-tool
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Import / Export Effects

IMPORT AND EXPORT EFFECTS

Import and Export effects Show Director feature works together and in conjunction with the 
Effect Filter Manager option.

A Filter is a part of the Effects File.
It could be a large number of effects corresponding to a macro area such as outdoor or
indoor, or several effects from a specific manufacturer.
You can filter by any entry in the Effects File.

EXPORT FILTERED EFFECTS:
1.First create a Filter name in the Effects Filter Manager. Make the selection of values for
every column.
2.Select the Filter in the Drop down menu. The Effects Manager will show only the Filtered
Effects.
3.Select Export Effects in the Effects Menu or click in the Icon
4.Follow direction in the Save Menu. A new Effects file will be created for the filtered effects.
Once you have exported the effects you have another effects file you can use and import in
different projects.

IMPORT FILTERED EFFECTS:
1.Select Import Effects in the Effects Menu or click in the Icon
2.Choose the File to Import

Created with the Personal Edition of HelpNDoc: Easily create PDF Help documents

Effects Merge

EFFECTS MERGE

Merge an existing Effects Manager into the currently loaded one by selecting Effects->Merge Effects.

It will update the Effects Manger with the new information in the merging Effects Manager.

http://www.helpndoc.com/feature-tour
http://www.helpndoc.com/feature-tour
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The Effects Filter File

The Effect Filter File

This File contains all possible Filter combinations for all columns that you create.
This file can be opened in multiple Projects, saving your preferred filters once for future use.
This window or selection panel creates the new or partial Effect Files to be exported by
selecting them in the Effect Filter view and Selecting Export. You can assign to every filter a
new Effect Manager.

NAME: In this field you enter the name of the Filter. The names of the Filter will be displayed
in the Drop-Down Tool-bar

When you select a name in the Drop-Down menu the Effect Manager will change accordingly
to the settings of the Filter.

COLUMN FIELDS:
The Columns in Green or Red are Ranges:
·FIELD in Green corresponds to IN value.
·FIELD in Red corresponds to OUT Value.

If values remain at 0, the range is not taken into consideration.

Sorts and Filters Selection 
You can select the Sort and Filter directly from the  Script or Effects Sort & Filter Managers.
Select the row and press enter will change the view of the Script or Effects Manager, and it
will be reflected in the drop down boxes where you previously had to do the selections.

Script Effects Filter from Effects Manager
By selecting a row or rows in the Effects Manager it will filter all the same effects present in the Script.  Do
this by pressing ENTER on a row in the Effects Manager.  
That will apply a filter on that Effects REF in the Script.  The Filter is additive so more or multi-select of
Effects rows will create more and more filtered Scripts. 
Use the existing Reset Filter to clear this filter.

http://www.helpndoc.com/feature-tour/iphone-website-generation
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Effect Filter Manager AutoCreate

You can now automatically create a set of Effect Filters based on column data from Effect
Manager.  Select a column in Effect Manager then in Effect Filter Manager double-click the
empty FilterName cell.  You can also AutoCreate with two neighboring 
Columns selected for a compound effect. A dialog will ask if you wish to AutoCreate the
filters, select Yes.  

A set of Filters will be created names based on the column or columns you selected and the
column data that matches at least one row in your Effect Manager.  

Filter Word based.
You can create a filter based in a single word or description. Name the Filter and Shift Double
Click in a cell containing the description. A dialog will ask you if you want to add that
description to the filter selected. Once included in the Filter you can delete the part of the
Description that you don't need and leave just the word. You can also type the word directly
in a Filter column.

Partial Match on Filters 
For Script and Effect Sorts, all text fields now will match case-insensitive on a partial sort. 
If, for example, you have a Sort for Description that is "Yellow" it will find all Descriptions with
the word "Crackling" or "crackling" or “CRACKLING".

Easy Add to Script- Effect Filter Manager
When you have a row selected in Script-Effect Filter Manager and you press Shift-Double
Click in a cell in the Script- Effect Manager, you will be asked if you wish to add that cell
data to the selected filter. Yes will add the data into the correct cell, No will go into normal
Edit for the cell. 
For the Columns VISUALREFERENCE, VIDEOLINK and PICTURELINK that have links to the Test
Viewer, Video Player or Website, to view the linked effects, just double click to view. Other
Show Director Changes
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Effects Filter File Operations

The Effects Filter File Operations

From the File Menu, the following functions are accessible for the Effects Filter File

·NEW

http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Creates a new file (it prompts for overwriting if the selected file exists)
·OPEN
Opens an existing file
·SAVE AS...
Saves a copy of the open File. It is useful to frequently save backups of your file.
·CLOSE
Closes the opened file

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

The Effects Sort File

The Effect Sort File

This file window contains all possible Sort combinations for all columns that you create.
This file can be opened in multiple Projects, saving your preferred sorts for future use.
All columns of the Script Manager are present in the Script Filter Manager.

You need to give a name to the Sort and then proceed to insert the values of your Sort
Order.
Value 1, will be the first column sorted, and so on. Positive values are sorting Ascending.
Negative values are sorting Descending.
The display order of the columns in the Effect Sort Manager will change accordingly to the
sort order, to help you visualize the Sort.

The Sort names will be displayed in the Script View tool bar:

Created with the Personal Edition of HelpNDoc: Create iPhone web-based documentation

Effects Sort File Operations

The Effects Sort File Operations

From the File Menu, the following functions are accessible for the Effects Sort File

·NEW
Creates a new file (it prompts for overwriting if the selected file exists)
·OPEN
Opens an existing file
·SAVE AS...
Saves a copy of the open File. It is useful to frequently save backups of your file.

http://www.helpndoc.com
http://www.helpndoc.com/feature-tour/iphone-website-generation
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·CLOSE
Closes the opened file

Quick and Additive Sort

1. Quick Sort by using the three new tool-bar buttons, Sort Ascending, Sort Descending and Clear
Sort.  Select a column that you want to be your primary sort.  Press either the Sort Ascending or
the Sort Descending button

2. If you select additional columns and presses either the Sort Ascending or Sort Descending buttons
it will add additional levels of sorting.  To clear the quick sort, press the Clear Quick Sort button.

3. Apply multiple Script or Effects Filters
a. Selecting one or more Script Filters or Effects Filters and Right Clicking will apply all filters

selected.

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

Effects Views

Effect Views

An Effect View is a combination of a Sort and a Filter.

You can name the View for quick access with the Drop-Down Menu in the Toolbar.

This is useful to view parts of the Script (Filters) sorted in a particular Order.

You will find many useful applications for this feature.

There is a limit of 32 names for Views in a Project.

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Grid Printing and Formatting

Grid Printing and Formatting

In this section we are going to explore the printing and formatting features of the new Show
Director grid.

Please take your time to explore this section because a well organized workspace really can speed up the
creation process.

See also Custom Reports

Created with the Personal Edition of HelpNDoc: Easily create HTML Help documents

Direct Print
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Direct Grid Print

Show Director prints all grids in WYSIWYG (What you see is what you get) format, as
displayed on screen.

You can also use LAYOUTS to create a view of the Script to print.

The printout may be different depending on the screen resolution used and type of printer.

You should create Print Templates in different Projects with the particular settings for each
printout. The settings will be saved in the Project and every time you open the project with
the Script you want to print, it will appear showing the Columns and in the sort order you
want them to appear.

In the creation of Print Project template you will use the following functions:

·Column order
·Hide
·Sort
·Font format
·Background Color

The Print Menu will allow you to adjust, margins, size and orientation of paper.

Each Print menu can be different depending on the type of printer used.

Created with the Personal Edition of HelpNDoc: Free EPub and documentation generator

Reports

Reports Menu

In this menu are the commands to create simple reports from Script File and Effects File.
Show Director includes a set of predefined reports. Those reports have been enhanced since
version 5.1.

From the [REPORT] menu the following functions are available:
·Script...
·Effects...

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Reports: Overview

Reports: Overview

http://www.helpndoc.com
reportEffect.html
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VISUAL SHOW DIRECTOR 8

107 / 119

Show Director creates various simple pre-defined Reports and Summaries.

Reports are Lists of all the data contained in the Script and Effects Manager, with the
applied Filter, and with predetermined sorts, following the order of the columns from left to
right.
Summaries are tables with computed information about Caliber use, by subtotals or for each
individual item. In the lower tool bar there is a summary of Cost for each Price category, that
you can update by pressing F8.

The Reports and Summaries open in a separate control window that you can leave open to
check as you script the show, or send it to Windows toolbar. The window has navigational
controls, page by page, zoom in and zoom out.

You may also save the report in a large variety of file formats, if you want to open it in
another application like Excel, Word, etc., to edit the format, alter the order of the columns,
sort it in a different way, apply other calculations or perform an enhanced printing.

If you require a more complete reporting, you can:

- Import the .scx or .efx files (a mdb format) into Microsoft's ACCESS database program.
- Export the whole Script or Effects Manager as a .csv file, open it with Microsot's EXCEL or
other spreadsheet/database application.

Show Director exports to a variety of formats that can be treated in other third party
applications.

For Custom Reports with the SD Tools Plugin go here

WATCH VIDEO CUSTOM REPORTS

Created with the Personal Edition of HelpNDoc: Full-featured EPub generator

Reports: Export and send by email

Reports: Export and send by email

Event or Script Reports and Effects reports can be delivered via email service or exported to
a variety of file formats for a more sophisticated printing layout.

To export a report:
Click on the export button (envelope icon) in the report window as shown in the next
illustration

https://youtu.be/saEDWJ2sPoo
http://www.helpndoc.com/create-epub-ebooks
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the following dialog appears with the all the available options.

Created with the Personal Edition of HelpNDoc: Easily create EBooks

Custom Reports (SD Tools Plug in)

Custom Reports and Views with Show Director Tools: Overview

We have added the ability to save a named Custom View that includes the Visible Script
Columns and their order plus whatever filters or sorts you may have in place.  These Custom
Views can be used in any project without having to load the original Script Filter or Sort files.
 
In addition to loading a Custom View, you have the ability to Print or Save the Script using
that View.  
Saving uses the Microsoft Excel format (.xls) and only saves the visible columns in order with
the filter and sort.  
This differs from normal Script Save as Excel which saves ALL columns and data.  
Use this feature to create Custom Reports that can be applied to any Project.  
A few commonly requested Custom Report Views have been included to get you started.

http://www.helpndoc.com/feature-tour
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Reports: Direct Printing

Reports: Direct Print

Show Director reports support direct printing.

To print a report:
Click on the Print button (Printer icon) in the report window as shown

Created with the Personal Edition of HelpNDoc: Easily create HTML Help documents

Script Reports
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Reports: Script

A set of predefined reports is available in the Script reports function.

Show Report:
This contains Shot, HHMMSSFF, Caliber, quantity, Type, Effect Description, Position,
Address, Caliber Group Hazard

Event Report:
This contains Shot, HHMMSSFF, next, Event description, Caliber, Quantity, Position, Angle,
Custom 1, Custom 2

Loading Report:
This contains Cue, Position, Address, Caliber, Quantity, Type, Effect Description, Reference,
Angle

Product Report:
This contains Reference, Caliber, Type, Effect Description, Magazine, Position, Quantity
Total, Address

Loading -Screen Sort Report:
This contains Cue, Position, Address, Caliber, Quantity, Type, Effect Description, Reference,
Angle

Set the sort order that you want in the Script with Cues Menu/Sort.

Select Loading-Screen Sort Report in the Reports Menu.

Product Summary:
his contains Reference, Caliber, Type, Effect Description, Magazine, Custom 1, Totals

Caliber Summary:
This contains Caliber and Quantities

Show Effects and Costs:
This contains Reference, Caliber, type, Effect Description, Quantity, Price 1,2 3 with Totals.

Created with the Personal Edition of HelpNDoc: Full-featured Help generator
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Effects Reports

Reports: Effects

A set of predefined reports is available in the Effects reports function.
Please remember that the reports are sensitive to the filters and sorts applied

Effect Report by Caliber :
This contains Caliber, Type, PFT, Duration, Effect description, Reference, Manufacturer,
Magazine, Price 1

Effect Report by Ref :
This contains Reference, Caliber, Type, PFT, Duration, Effect description, Manufacturer,
Magazine, Price 1

Effect Report by Type :
This contains Type,Caliber, PFT, Duration, Effect description, Reference, Manufacturer,
Magazine, Price 1

Effect Report Screen Sort :
his contains Caliber, Type, PFT, Duration, Effect description, Reference, Manufacturer,
Magazine, Price 1

Export all Columns :
This Contains all the Columns of the Effect Manager

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Configuration

Configure Menu

In this menu we have the commands to customize and configure the Timecode and the Wave
Display.

From the [CONFIGURE] menu the following functions are available:

EffectSortsFile.html
http://www.helpndoc.com
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·Time Code
·Wav Display...

Created with the Personal Edition of HelpNDoc: Easy EBook and documentation generator

Configure TimeCode

Configure TimeCode

·External Pyrodigital modem (Pyrodigital Time Code)

You will select this option if you are using the Pyrodigital modem connected to the com port
of your computer with an audio input from a tape with music and Time Code, or a wave file
with music and Time Code playing from your computer.
You can play from the computer while Show Director is running. You will need to take a feed
from the computer external audio L&R channels to one speaker and to the PD modem.

A two-channel (stereo) tape with a Soundtrack and Pyrodigital Time Code recorded.

Use this function if you are using a Tape Player, CD Audio with Music in the Left channel and
Pyrodigital Time Code recorded in the Right Channel. You can play the CD from your computer
CD ROM player. Connect the external audio stereo feed to the speaker and to the Pyrodigital
Modem, respectively. To control the CD use the Microsoft CD player controls. Those include
forward, rewind and a clock that matches the Time Code clock. This is the most reliable way
to script the show as you have complete guarantee that there are no gaps due to the
possible interference of other computer internal operations.

Internal CD ROM

If you have a CD player attached to the computer you can play CDs and capture cues
directly from them. You will save these song scripts with different names. After, when you
edit the music soundtrack from the same CDs, you will have to cue first the starting cues of
each song, and with the command Import Cues insert the song files already cued to the
starting cue of each song. We will demonstrate this later, in the Import Cues menu.

If you have your soundtrack burned into a CD-ROM or just scripting songs to a CD-Audio, you
can also use the CD to capture cues. If you are preparing a show you can capture cues from
songs on various CDs, and when your final soundtrack is edited import the scripts at the
offset times.

IMPORTANT:
If you are using a CD ROM, with your soundtrack you have to be aware that some CD
recording software requires a minimum of 2 seconds pause in the first track. When you play
the CD you may observe that the music cues are offset by 2 seconds. To correct this you
will need to offset all your cues in the Script by 2 seconds.

To do so:
1. Select the first row and while pressing the Shift cue, select the last row.Go to Cues

menu and select Export Cues. The save Export cues window will appear. Give a name
to the Exported cues, ex: 'Script2sec'.Go back to the Script and select all the Rows,
by selecting the first row, pressing Shift and selecting the last row, then press
delete.Your Script is empty.Go to the Cues menu and select Import Cues. The Import
cues window will appear.Select Insert Cue at time, and enter the offset, 2 sec=
00:00:02:00Click OK.

http://www.helpndoc.com
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2. The new cues will fill the Script with the 2 second offset.
You will observe that the music cues and Script cues now match while playing back.

If you are firing the show with a CD, with Music in the Left and Pyrodigital time code in
the right channel, the CD recording software pause does not affect the
synchronization, as both channels are playing simultaneously.

A Wave file (.wav):

Wave file configuration is automatically selected when you open a Wave File from the
File Menu. (See Configuring Wave Display)

·SMPTE Time Code

Show Director supports Scripting directly with SMPTE Time Code. SMPTE Time Code is input
through a new, optional external SMPTE Time Code Reader, in a manner similar to the
Pyrodigital Time Code Modem.
This new SMPTE Modem is available from Pyrodigital Consultants or Infinity Visions.
Show Director and the new SMPTE Modem support 30fps, 29.97fps-Drop Frame, 25fps, and
24fps.

For more information about the use of SMPTE and the Modem, click here

· SMPTE Time Code
Enable Beep during cue capture.

If you want to hear a beep during cues playback you have to enable this function.
The beep is actually a. wave file, and you can make any beeps, sounds or words like Fire!
sound at every cue.
If you want to change beeps go to Windows Settings-Control Panel-Sounds, Select
Default Sound, Browse to Sound Director Folder, we have provided you with a collection.
If you want you can create your own with Microsoft Sound Recorder.

If you can not hear any beeps, check that your multimedia controller for sound has the
.wave listening enabled.

Depending on the Time Code option that you choose, you will have to change the Time
Code Configuration. The default configuration is Pyrodigital Time Code /SMPTE 30fps, and
Port1.

The TimeCode dialog has had additional ComPorts added, upping it from 4 to 16

· With Show Director Tools Plug-in it is possible to generate SMPTE timecode.

smpteModem.html
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Configure Wave Display

Configure Wave Display

If you want to change the colors of
·the Wave Background
·the Wave foreground

http://www.helpndoc.com/help-authoring-tool
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·the Caliber plot color
·the Cue plot color
·the Cursor Color

or you want to display or not cues or caliber, you can open the Wave Configuration Display
under the Configuration Menu, and make your selection.

Created with the Personal Edition of HelpNDoc: Easily create EPub books

Firing Tables Manager

FIRING TABLES MANAGER

Firing Table selection and Download

·All the Download operation is conducted with one single Control Panel in the Manager
Window
·The Firing Table selection is done with the Script Filter Manager, as explained in the Script
File Section.
·If no Filter is used, all cues are taken to make a unique Firing Table for Download.
· The number of selectable ports is 16. The port with the Field Controller connected, will
show the mark <<

If you have used Filters to separate and specify each Firing Table, the Script Filter Manger
will look like this:

http://www.helpndoc.com/feature-tour
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And the Firing Table Manager, like this:

Field Controller: Selects the Field Controller Number. Firing Tables: Selects the number of
Tables in conjunction with The Field Controller Memory settings.

Serial Port: Chooses the serial port to send the data to the Field Controller.

Status: Shows the status of the Firing Table: Pending, Downloaded or Failed

If you make a change in the Script, make sure to click UPDATE or UPDATE ALL, to
reflect the changes in the file downloaded to the Field Controller (.tab)

Click DOWNLOAD and follow the messages to download to the Field Controller.

OK. Saves the settings and exits the Firing Table Manager.

PYROINFINITY FIRING MANAGER

This new firing table manager is used to create firing files for FireDirector control software 
and to program Monetti SQ3 sequencers.
You can download each SQ3 individually. Tables for each module are created automatically
by Show Director.
For operation of the Monetti SQ3 refer to its user's guide.

http://www.monetti.net/sq3.htm
http://www.monetti.net/sq3.htm
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Visual Show Director Manual Mode

Manual Mode

A new Manual Mode has been integrated in the program to allow the choreography of
manually fired shows with electric panels.

Description of Manual Mode, when manual mode is entered:
·If the script window is on the screen, the PFT (PreFire Time/Delay) column is locked (i.e.
edits not allowed) and the time (HMSF) is adjusted by the PFT. The time displayed is the Fire
Time. The PFT column is locked, so that when manual mode is terminated, time is converted
back to the original event time (Firing Time + PFT).

·If the script window in not on the screen, when the script is opened the script will be
converted to the manual mode (i.e., the time will be adjusted to Fire Time).

When manual mode is active, the Manual Pull Down Menu is enabled. This Menu has
the following functions:

http://www.helpndoc.com/feature-tour
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·CountDown Display
·Configuration
·Renumber Cues
·Validate with Tolerance
·Add PFT
·Subtract PFT

Configuration...
This screen contains all the Manual Mode parameters: The current set includes:

·Cue tolerance
Specifies how near cues can be to each other. The validate function will use this number to
compare cue times (if cues are too close together, they are difficult to Fire on a manual
panel, consolidate or adjust the script as required).
·Response Time
Sets the number of tenths of a second at which the "FIRE" wave file is to be played, to
compensate for the Firing Operator's Delay in physically initiating the Firing button/probe on a
manual Firing board.
·Cue Preview Time
Set the delay that you want the cue to be announced before it turns red in the display.
·Max Cue Number
Set the maximum number of cues of your firing panel per rail/slat before it restarts the cue
count. If you have 25 cues per slat set it to 25.

CountDown Display
This window has a countdown HMSF/ Next Cue number /and Fire indicator. Everything is in
big fonts for easy visibility.

Renumber Cues
This function allows a quick and semi-automatic addressing of the number of Firing Positions
per rail/slat on the manual firing system. It is possible to set the number of cues per rail/slat
and automatically renumber all the script

Validate with Tolerance
This function flags occurrences of inter-cue times that do not meet the specified tolerance.
The user specifies a tolerance and is able to select all, or selected cues for validation. It
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operates similar to the address validation in that the user is able to ignore/proceed past
conditions that fail the check. This function insures that user has not specified cues too
close together for actual operation of the manual firing system.

Add / Subtract PFT
This function gives the option to add or subtract the PFT.

USE OF THE WAVE DISPLAY WITH MANUAL MODE

With the new wave display it is possible to combine the Graphic display of the cues on the
wave graphic with the Manual Countdown Panel. You will need to deselect wave display and
caliber display in the Configure Wave-Options.
This way you will have a graphic plot of the cues only. While you play the music you will be
able to see the cues coming while the cursor advances and looking at the Count Down
announce the cue number.

Created with the Personal Edition of HelpNDoc: Free EBook and documentation generator

http://www.helpndoc.com

	VISUAL SHOW DIRECTOR 8 Getting Started
	Introduction
	How to use this guide
	Other Resources
	Upgrading to version 8 from previous versions
	Language Settings


	Show Director Overview
	The Toolbars
	Toolbars Interaction
	Toolbars Customization
	Script and Effects Managers Common Tools

	Visual Applications
	FX-Generator
	Producer
	3D Position Editor
	Viewer
	Interface
	Options



	Grid Formatting Layouts
	Grid Formatting by Columns
	Hide / Show Columns
	Repositioning Columns
	Custom Views
	Layouts

	The Creation Process
	Software User Folders Structure

	The Project
	Create a New Project
	Open an Existing project
	Save a Project
	Close a Project
	The Project Library
	The Wave file
	The Visual Files

	The Script File
	Create a New Script File
	Open an existing Script File
	Save Copies of the Script File
	Import a Script File from other Firing Systems
	Export a Script to other systems
	Auto Restore - Undo
	Scripting  for DMX

	Scripting Commands and Syntax of Visual Columns
	QTY
	PAN & TILT
	CAMERA
	VISUAL REFERENCE
	BEAM
	WORLD
	OBJECT
	VIDEO LINK & PICTURE LINK

	Working with Cues
	Save / Clear New Cues
	Copy, Cut, Paste and Duplicate  Cues
	Insert Cues
	Insert Effects
	Create Effects
	Update Effects
	Create Macro
	Capture Cues/Automatic Beat Detection
	Renumber Cues
	Renumber Addresses
	Validate Addresses
	Reset Addresses
	Offset Time
	Refresh Grid
	Column Fill Down
	Cues Invert
	Cues Auto Complete
	Locate
	Import / Export Cues
	Import Beat
	Export .Chr (Visual Script File)

	The Script Filter File
	Script filter File Operations

	The Script Sort File
	Script Sort File Operations
	Script Views

	The Effects Manager
	Create a New Effects File
	Open an existing Effects File
	Open and Save Effects  Managers in .csv .xls .efx

	Working with Effects
	Refresh Grid
	Duplicate Effects
	Column Fill Down
	Locate Effect Ref#
	Total Effect
	Total All Effects
	Update Effect Total
	Import / Export Effects
	Effects Merge

	The Effects Filter File
	Effects Filter File Operations

	The Effects Sort File
	Effects Sort File Operations
	Effects Views

	Grid Printing and Formatting
	Direct Print

	Reports
	Reports: Overview
	Reports: Export and send by email
	Custom Reports (SD Tools Plug in)
	Reports: Direct Printing
	Script Reports
	Effects Reports

	Configuration
	Configure TimeCode
	Configure Wave Display

	Firing Tables Manager
	Visual Show Director Manual Mode

